


Page 2 of 162

This page intentionally left blank.



Orchid Modules

Table of Contents
Extender Configurator Tutorials 9

A/R Credit Limit Approval 10
Overview 10
EXTENDER SETUP KEY STEPS 10
Workflow template - Step by step guide 10
Attach workflow to AR0024 {AMTCRLMT} Field 14
Configure Information Manager 15
testing Sage 300 workflow setup 16

Customer On-Hold Alert and Approval 18
Overview 18
Extender Setup key steps 18
Workflow template - Step by step guide 18
Attach workflow to AR Customer Inquiry screen 21
Using Extender workflow to set customer on hold 22

Use Icon on AR Inquiry screen to put on hold 22
Viewing workflow history and logs 22

O/E Orders Approvals 23
Overview 23
Extender Setup key steps 23
Workflow template - Step by step guide - OE New Retail orders on hold 23
Workflow template - Step by step guide - O/E orders on hold approval 26
Attach workflow to OE0520 View 28
Configure Information Manager 29
Using Extender 30

P/O Requisitions and Purchase Order Approval 32
Overview 32
EXTENDER SETUP KEY STEPS 32

Configure SMTP Email settings in Extender Options 32
Configure Workflow Users 32
Create Workflow User Group 33
Add Workflow colours 33
Import the PO Approval.vi file 34
Configure the PO approval module - Print settings 34
Configure the PO approval module - User delegated amount and manager 35
Configure approving user 36
Optionally, configure module to use Remote Action in workflow template 36
Auto approve PO from requisitions – 37

Workflow template - Step by step guide 38
testing Extender workflow setup 39

Start the workflow 39
Approve or Reject the Purchase Order or Purchase Requisition 40

Page 3 of 162



Orchid Modules

Software Required 41
A/P Payment Batch Approval 42

Overview 42
EXTENDER SETUP KEY STEPS 42

Configure SMTP Email settings in Extender Options 42
Configure Workflow Users 42
Create Workflow User Group 43
Add Workflow colours 43
Import the AP Payment Batch Approval.vi file 44
Configure the AP Payment approval module 44

Workflow template - Step by step guide 45
testing Extender workflow setup 49

Start the workflow 49
Approve or Reject the A/P Payment Batch 49

Optionally, Configure Information Manager 50
Software Required 52
Using with Remote Action Service 52

Vendor Alert Manual workflow 53
Overview 53
Extender Setup key steps 53
Workflow template - Step by step guide 53
Attach workflow to AP Vendor screen 55
Using Extender workflow to start the AP Vendor manual workflow 56

Use Icon on A/P Vendor screen to send an alert 56
Viewing workflow history and logs 56

I/C Options Notification 57
Overview 57
EXTENDER SETUP KEY STEPS 57
Workflow template - Step by step guide 58
Attach workflow to IC0380 {SEXPDAYS} Field 60
Configure Information Manager 60
Testing Sage 300 workflow setup 60

Setting Up Extender Workflow 63

Before you start 63
setup workflow in extender 64

Step 1. Use the icons in the Extender Setup folder to configure workflow: 64
Step 2. Setup Extender Adding Security on page 1 in Sage 300 Administrative Services. 64
Step 3. Configure Workflow Users. 64
Step 4. If you want the workflow to send emails, 64
Step 5. Create Workflow User Groups 64
Step 6. Configure Workflow colors 64
Step 7. Add Workflow Templates 64

Apply Workflow to the required Sage 300 Views. 64

Page 4 of 162



Orchid Modules

A workflow can be started automatically 64
A workflow can be started manually 64

Optionally, add icons to Sage 300 screens 65
Installing Extender 65

Installation Steps 65

Before you Start 65
Installing the files 65

Activate Extender 66
License Details 66

Enter License Details 66
Upgrading from a prior version 67
Minimum Requirements 67

Extender License Screen 67
License screen 67

Workflow Users 68
30-day Trial Licence 68
Extender license screen details 69
Subscription Licenses Expiry Date 70

Extender and Orchid modules web screens 70
Troubleshooting Activation Code 71
Activation code and available functionality 71

Adding Security 71
Extender security and workflow users 73
Custom Table Security 73

Options 73
Options Tab 73

Log User Sign in : Yes or No. 73
Python Version 74

Email Tab: enter Email server details 74

Updates Tab 74
Extender Email Tab 75

Email Field details 75

Basic Authentication SMTP: 75
Microsoft Graph: 76

Examples 76
Test Email Configuration 77
Troubleshooting Sending emails 77
SMTP Email Examples 77

Email with Office 365 77
Using Office 365 and MFA 77
TLS Version 78

Using Gmail 78
Using SendGrid 79

Page 5 of 162



Orchid Modules

Using Hotmail 80
Email Troubleshooting 80

Failure sending mail 80
Port 80
Legacy Authentication 80
TLS Version 80

You get the message “E-mail sent”, but no email is received, 81
Process Scheduler emailing tips 81

Updates Tab 82
Extender License and Workflow Users 82

Maintain Workflow Users 82
Upgrade Steps for Workflow Users 83

Understanding Workflow Users 83
Setup Workflow Users 83
When do you need workflow users 83
Workflow template and Workflow Users 84
How do Workflow Users work? 85

WORKFLOW USERS are NAMED user licenses: 85
Workflow Colours 85
Workflow User Groups 85
Message Templates 86

Message Templates Field List 86
Message Variables 87
Attachments 87

To configure: 87
How it works: 87

Using HTML messages 87
Workflow Templates 88

Workflow Types 88

A workflow can be started automatically 88
A workflow can be started manually 88
Completing a workflow 89

Using the workflow 89
Setup Workflow templates - Overview 89

Workflow Templates - Screen Guide 90
Workflow template configuration 90
Workflow Steps 92
Progress-to Steps 93
Workflow Actions 93
Workflow Values 104

Link Workflow template to Extender view or Screen 105
To start a workflow automatically: 105
To start a workflow manually: 105

Page 6 of 162



Orchid Modules

View Events, Scripts & WF 106

Select a Sage 300 View to be configured with Extender. 106
Fields and Controls 106
Events Tab 107
Scripts Tab 108
Workflow Tab 109

Extender Workflow- Notes/DML/Extender Tray 111

Configure Tray 112
Fields and Controls 112
Examples 114

Configure Orchid User 116

How do Orchid Users work? 116
DML USERS ARE CONCURRENT ("FIRST COME, FIRST SERVED") LICENCES: 116
WORKFLOW USERS are NAMED user licenses: 116

Setup DML User 116
Setup Workflow User 118
Setup Workflow Anywhere User 118

Remote Action Service : Progress Extender Workflow remotely 118
Remote Action Service - Getting Started 119

Prerequisites - install Extender and Remote action service 120

Extender setup 120
Install Remote Action Service 120
Install Process Scheduler 121

Configure Remote Action module 122
Configure Remote Action poller 122

Running the Poller with Process Scheduler 123

Using Extender Workflow 125

To start a workflow manually: 125
Progress Workflow on the Workflow Console 125
Using Icons on Sage 300 screens 126
Progressing Workflow Outside of Sage 300 126

Using Remote Action Service 126
Using Workflow Anywhere 126

Workflow History 126
Using Workflow Console 127

Console and Security Groups 127
how to use console grid 127
how to use console buttons 128
workflow template configuration and console layout 129

Workflow Detail Log 130
Workflow Log buttons 130

Page 7 of 162



Orchid Modules

Workflow Summary Log 131
Workflow Summary Log buttons 132

Print Workflow History Log Report 133
Using Extender Tray Icons 134

Workflow Technical Info 135

Workflow Icons Explained 135
Configurator Actions 136

Parameters to be used in workflow actions 144
Using Parameters in Workflow 145
Drilldown in workflow 146

Using the SetDrilldown action configured in the vidrilldown.ini or viuserdrilldown.ini files 147
Using Workflow value to configure drilldown 150

Workflow Best Practices Tips 150
General 150
Actions in workflow template 151
Approval workflow to prevent fields being updated. 151
Actions in steps and workflow console 152
Configurator actions that require another one. 152

Writing custom actions for Workflow 153
Naming Extender scripts used as Workflow Actions 153
Scripts return value 153
Workflow actions and parameters 153
Actions have up to 4 parameter fields 153
Workflow actions can have finders for the parameters. 154
Examples: 154

Remote Action Service : Progress Extender Workflow remotely 155
Remote Action Service - Getting Started 156

Prerequisites - install Extender and Remote action service 157

Extender setup 157
Install Remote Action Service 157
Install Process Scheduler 158

Configure Remote Action module 159
Configure Remote Action poller 159

Running the Poller with Process Scheduler 160

Page 8 of 162



Orchid Modules

Extender Configurator Tutorials
Review examples to configure Sage 300 to log changes to records, send an email or create an Inform-
ation Manager Note.

A/R Credit Limit Approval 10
Customer On-Hold Alert and Approval 18
O/E Orders Approvals 23
P/O Requisitions and Purchase Order Approval 32
A/P Payment Batch Approval 42
Vendor Alert Manual workflow 53
I/C Options Notification 57

Extender Configurator Tutorials Page 9 of 162



Orchid Modules

A/R CREDIT LIMIT APPROVAL

Overview

A company wants to configure workflow using Orchid Extender to control who can approve
A/R Customer credit limits.

Users can approve up to $10,000

Between $10,000 and $50,000, a user in the A/R Team must approve and the Workflow console must
display the request in Yellow

Above $50,000, Anne must approve. Credit Limit requests above $50,000 must show in Red in the Con-
sole.

Tip: You can import the "Customer Credit Limit multi-level" Sample workflow.

EXTENDER SETUP KEY STEPS
This A/R Credit Limit workflow template is designed to be started automatically when the A/R Credit
Limit field is updated in Sage 300. The workflow will restore the original credit limit until the request is
approved.

1. Configure Workflow Users. Refer to Extender License and Workflow Users on page 82
2. Create User Group "ARAPPROVER" and add Sage 300 users that are in the A/R Team

to approve credit limits up to $50,000. (Workflow User Groups on page 85)
3. Configure SMTP Email settings in Extender Options (Extender Email Tab on page 75)
4. Add message templates (In the example workflow, 3 templates are

used: WFARCUSTCLMT when the credit limit changes, WFARCRLIMTAPPR when
request is approved, WFARCRLMTREJECT when request is rejected) (Message Tem-
plates on page 86)

5. Add Workflow colours : Urgent (colour = Red) for large credit limits, Yellow for
pending requests, Approved (colour = Green) (Workflow Colours on page 85)

6. Create a "Workflow Template" in Extender Setup > Workflow Templates
7. To attach the workflow to the A/R Customer view, refer to Attach workflow to AR0024

{AMTCRLMT} Field on page 14
8. To configure workflow icons on screens, refer to Configure Information Manager on page 15

Workflow template - Step by step guide
It is recommended to add the main steps as defined on the process flowchart first, and then configure
the detailed actions for each step.
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For details, refer to Workflow Templates - Screen Guide on page 90

WORKFLOW CONFIGURATION
Template ID - Enter a descriptive name.

The name cannot be updated after it is created

Can start manually: set to No as the workflow will start whenever the Credit Limit changes and will
be attached to the A/R Customer view.

Auto Delete instance when complete: No - while testing.

You can set it to Yes later- if there are too many records in the Console, as the workflow history is
accessible in the Log.

Can start multiple instances: Yes - If you want the workflow to behave differently if there is an
active pending workflow before a new one starts, use the "IfWorkflowExists" action.

Warning!
When you select "No" or "No with Message", if you update a field/View configured with the work-
flow template, and an existing workflow instance is active, the workflow is not triggered.

This may disable controls you are implementing with this workflow where this workflow has an act-
ive instance is active. USE WITH EXTREME CAUTION. Consider using the "IfWorkflowExists" action
and "Can start multiple workflow" = Yes

WORKFLOW STEPS
Add 5 steps - The detailed actions for each steps will be configured below.
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Check - Entry Step: Compare the credit limit requested to the business limits and
based on the result, determine what actions to take, is an approval required, is an
alert or notification required?
Wait - Record is waiting for approval.
Approve - Approving User to confirm the amount approved, enter a comment and
when the credit limit is updated in Sage, send an email confirmation to the user who
started the workflow.
Reject - Rejecting user to enter a comment.
Reassign - this template uses a custom Reassign action so that the new user
assigned can receive an email.

PROGRESS-TO STEPS
Progress-to steps are used when a user needs to select the next Step to progress the workflow. Pro-
gress-to steps add Controls to the workflow console. If workflow screen icons are configured in
Information Manager, Progress-to steps can be run from the configured Sage 300 screen.

For A/R Credit Approval, the request can be Approved or Rejected.

Select the Wait Step, add 2 steps that a user can select: Approve and Reject

VALUES
Values are used in the workflow and saved in the workflow history.

For A/R Credit Approval, the workflow will track the Customer ID to enable drill down, custom
description fields and Approvers.

Customer: to enable drilldown - Set in the first workflow step
ORIGCRLIMT: original credit limit - Set in the first workflow step

Values are also used as variables in the workflow actions. In this example, we have configured Values
to store the Approver details.

ARUSERLMT: (e.g. $10,000) Below that amount, no approval is required
ARMGRLMT: (e.g. $50,000) Above that amount, a manager approval is required
ARUSERAPPROV: ARAPPROVER, as defined in the Workflow User Groups above.
User group that can approve up to a certain amount
ARMGRAPPROV: Manager who can approve the larger credit limit requests

ACTIONS
For each step, the template includes a series of actions to match the process flow requirements. In
the A/R Customer Credit Limit approval, the most commonly used actions are configured.

For a list of actions included with ExtenderConfigurator, refer to Configurator Actions on page 136
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CHECK

SetDrilldown: Set the CUSTOMER value to the current customer to enable drilldown from the
console

Evaluate: Used to compare the requested credit limit to the Amounts that require approval. If the
Credit Limit is greater than $10,000, go to the True action to evaluate if it is greater or not than
$50,000.

If it is not greater than $10,000, go to the False action (complete the workflow as no approval is
required).

AssignUser: Enter the appropriate user based on the amount

AssignColour: Enter the required colour based on the amount

SetField: Used to restore the original credit limit - This prevents the credit limit being saved

Tip: Make sure that the False action notifies the user that there was an issue preventing the
update.

SetDescription: This will be displayed on the console. Use {NAMECUST}-{IDGRP} to show the
Customer name and Group.

SendEmail: Choose a template and the Sage 300 user. The email address will be from the User
profile in Sage 300.

GoToStep: Choose Wait step if approval is required so that users can Approve or Reject on the
console.

WAIT

This step has no action, as it is waiting for a User to progress the workflow.

APPROVE

AddParameter: Add 2 fields: 

APPRCRLIMT to confirm the Approved credit limit. Defaults to {TOVALUE}, the
requested value.
APPRCOMMENT: for approver to enter a comment

AskForParameters: always required after AddParameter to display the popup screen and wait
for user to enter Input.

SetField: This action will save the credit limit entered on the screen. The value should be the para-
meter name as entered above {APPRCRLIMT}.

{TOVALUE} is the originally requested credit limit. If you are not prompting the user to confirm
the amount or enter a new one, you can use this to update the Credit Limit.

The True action can complete the workflow.
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False Action: this means the Credit Limit wasn't updated (for example, the approver doesn't have
rights to Sage 300). Make sure this goes back to the Wait step and doesn't complete the work-
flow.

SendEmailToStarter: Select a template. The action will use the email address in the Sage 300
user profile of the user who started the workflow.

GoToStep: Go back to Wait if the field update has not been successful.

REJECT

AddParameter: Add 2 fields: 

REJECTREASON: for user to enter a comment / reason for rejection

AskForParameters: always required after AddParameter to display the popup screen and wait
for user to enter Input.

SendEmailToStarter: Select a template. The action will use the email address in the Sage 300
user profile of the user who started the workflow.

Complete: Completes the workflow. Will be deleted from the Console if "Auto delete"is set to
Yes.

Attach workflow to AR0024 {AMTCRLMT} Field
The workflow template is attached to the A/R Customer view (AR0024) so that the workflow starts auto-
matically when the Credit Limit is updated.

DETAILED STEPS
Extender Setup > View Events and Scripts.

For detailed steps, refer to View Events, Scripts & WF on page 106

Select AR0024 view, on the Workflow Tab, select the Customer Credit Limit workflow and "Check" as
the Entry step.
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Tip:
You can also use up to 4 parameters configured in View Events and Scripts > Workflow Tab. Para-
meters need to be used in the Workflow template using SetValue.

Using Parameters in Workflow

Configure Information Manager
Optionally, install and activate Information Manager

This is required if you want to add icons on relevant Sage 300 screens to view and progress workflow.

CONFIGURE ICONS ON SAGE 300 A/R SCREEN
To view the workflow history and progress active workflow from the AR Customer screen, configure
Information Manager , I/M Setup > Options > Notes/DML/Extender hotkey

Extender Workflow- Notes/DML/Extender Tray

As the workflow cannot be started manually, do not select an Entry Step.

A/R Customer workflow on A/R Screens

If you have an A/R Credit Limit approval workflow, you can add the icons to selected screens: 

A/R Customer Screen- RotoID = AR1300 and Field Label = Customer Number
A/R Customer Inquiry screen - RotoID = 1700, and field label = Customer No
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Refresh the Tray icon if you have made any changes on the IM Setup>Options in the current session as
the Tray icon reads the current setup when the company is first opened.

Tip: If you have multiple Tray icons, Close the Sage 300 desktop and re-open to refresh the con-
figuration.

testing Sage 300 workflow setup
The workflow is started when the A/R Customer credit limit is updated (by a user on a Sage 300 screen or
by an import or a custom process using the Sage 300 Views).

Update the credit limit for a Customer in A/R - E.g. change the credit limit from $10,000 to $15,000

When you save the A/R Customer, the credit limit remains set to $10,000.

USING THE WORKFLOW CONSOLE
Go to Extender Console, notice the workflow instance record.

Click on Values Tab to see the details.

Use history to view the steps that the workflow has been following.

Log on as a Workflow user who can approve,

click Approve on the console.
Confirm the credit limit to approve and a comment
Drill down to the AR Customer to check.

USING TRAY ICONS
Log on as a user who can approve,
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Find the customer or drill down from the console
Click on the Workflow icon, select Reject
Enter a reason
Confirm the email is sent to the user who started the workflow.

Requirement!
This functionality is available in Extender Levels Configurator and Developer.

This functionality requires Extender Developer.

To approve on the Remote form without logging to Sage 300 first, you need an active subscription to
the Remote Action Service. You can then configure the workflow template to use Remote Action.

To use the Workflow console, configure the user as a "Workflow User". Refer to Understanding Work-
flow Users on page 83

To use the Tray Icon on the Sage 300 screens, you need to install Information Manager, configure the
tray icons and configure the user as a "Workflow User".
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CUSTOMER ON-HOLD ALERT AND APPROVAL

Overview
AR Team users need the ability to put a customer on hold and send an email to the primary sales per-
son for the customer.

The company requires 2 different users to approve sequentially before the customer can be taken off-
hold.

Extender Setup key steps
To achieve the requirement, we will create a workflow template that can be manually started and con-
figure an icon on the A/R Customer inquiry screen.

Add email templates
Create a "Workflow Template" in Extender Setup > Workflow Templates - Set Cus-
tomer on hold and notify sales person.
Add Workflow Users - Understanding Workflow Users on page 83
Add Information Manager Configuration to start the Extender Workflow.

Workflow template - Step by step guide
WORKFLOW CONFIGURATION

Template ID - Enter a descriptive name. The name cannot be updated after it is created

Can start manually: set to Yes

Note: You need to configure what screen the workflow can be started on in I/M Options >
Notes/DML/Extender Tray setup.

Auto Delete instance when complete: Yes

Can start multiple instances: No with Message- to ensure the first request is completed before a
new one starts.

It is recommended to add the main steps as defined on the process flowchart first, and then configure
the detailed actions for each step.

For more details. Workflow Templates - Screen Guide on page 90

WORKFLOW STEPS
Add 6 steps - The detailed actions for each steps will be configured below.

Set On Hold : Entry Step. Assigns the workflow to Nathalie
Wait : Record is waiting for approval.
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Approve 1 : Assigns the workflow to Anne for second approval.
Waiting for 2nd Approval: Record is waiting for final approval
Take Off hold : 2nd Approver can take the customer off hold.
Reject : Close the workflow and leave the customer on hold.

PROGRESS-TO STEPS
Progress-to steps are used when a user needs to select the next Step to progress the workflow. Pro-
gress-to steps add Controls to the workflow console. If workflow screen icons are configured in
Information Manager, Progress-to steps can be run from the configured Sage 300 screen.

In this example,

Select the Wait Step, add 2 steps that a user can select: Approve 1 and Reject
Select the "Waiting for 2nd approval" step and add 2 steps "Take off hold" and
"Reject"

VALUES
Values are used in the workflow and saved in the workflow history.

For Customer On Hold manual workflow, the workflow will track the Customer ID to enable drill
down, custom description fields and Approvers.

Customer: to enable drilldown - Set in the first workflow step

ACTIONS
For each step, the template includes a series of actions to match the process flow requirements. In
the A/R customer on hold manual workflow, some of the key actions are described in this tutorial.

For a list of actions included with ExtenderConfigurator, refer to Configurator Actions on page 136

SET ON HOLD

SetValue: {VIEWID} - This is required for a manual workflow to attach the workflow to a Sage 300
View. View fields are now available in the workflow actions and in message templates.

SetDrilldown: Set the CUSTOMER value to the current customer to enable drilldown from the
console

AddParameter and AskForParameters: Prompt user for a reason to store in the workflow values.

AssignUser: Enter the appropriate user based on the amount

SetStatus: Set the workflow status to "Customer on Hold"

SetField : Used to Set the customer on hold {SWHOLD} = 1

Tip: Make sure that the False action notifies the user that there was an issue preventing the
update.
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SetDescription: This will be displayed on the console. Use {NAMECUST}-{IDGRP} to show the
Customer name and Group.

SendEmail: Choose a template and the email address to use

GoToStep: Choose Wait step if approval is required so that users can Approve or Reject on the
console.

WAIT AND WAITING FOR 2ND APPROVAL

The Wait steps have no action, as it is waiting for a User to progress the workflow.

APPROVE/FIRST APPROVAL

This step doesn't take the Customer off hold, it stores the User who first approved and assigns to
a second user.

SetValue: This action stores the User who approves - Value = APPROVER1, Field = {USER}

AssignUser: Enter the 2nd approver user. Could be a user group.

SetStatus: Enter a status meaningful for Workflow log and reports.

GoToStep: Go back to Wait if the field update has not been successful.

OFF HOLD/2ND APPROVAL

Evaluate: If the logged on user is the same as the first Approver, Display an error and go back to
Wait step.

If the logged on user is different from the first Approver, take the customer off hold.

SetField: This action will take the customer off hold. {SWHOLD} = 0

The True action can complete the workflow.

False Action: this means the On Hold Flag {SWHOLD} wasn't updated (for example, the approver
doesn't have rights to Sage 300). Make sure this goes back to the Wait step and doesn't complete
the workflow.

SendEmailToStarter: Select a template. The action will use the email address in the Sage 300
user profile of the user who started the workflow.

SetStatus: Enter a status meaningful for Workflow log and reports.

GoToStep: Go back to Wait if the field update has not been successful.

REJECT

SetStatus:  Rejected - Used on console and workflow history.

AddParameter: Add 2 fields: 

REJECTREASON: for user to enter a comment / reason for rejection
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AskForParameters: always required after AddParameter to display the popup screen and wait
for user to enter Input.

SendEmailToStarter: Select a template. The action will use the email address in the Sage 300
user profile of the user who started the workflow.

Complete: Completes the workflow. Will be deleted from the Console if "Auto delete"is set to
Yes.

Attach workflow to AR Customer Inquiry screen
To start the workflow manually, you don't need to add it to Extender Setup > View Events and Scripts.

Instead, you add the configuration in I/M Options > Notes/DML/Extender Tray setup.

Requirement! This requires to install and activate Information Manager. If you are only using Extender
screen icons functionality, you can install the module without activation code.

Select RotoID AR1700 for Customer Inquiry.

Field Label: Customer No.

Select the workflow template and an Entry Step.

Enter Approver 1 and Approver 2 users in Parameters 1 and 2.

Refresh the Tray icon if you have made any changes on the IM Setup>Options in the current session as
the Tray icon reads the current setup when the company is first opened.
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Tip: If you have multiple Tray icons, Close the Sage 300 desktop and re-open to refresh the con-
figuration.

Using Extender workflow to set customer on hold

Use Icon on AR Inquiry screen to put on hold

Find a customer with overdue invoices that you want to put on hold. Start the workflow on the Screen
icon.

Enter a comment when prompted.

The customer is put on hold and the sales person receives an email with the custom reason.

When the first user has approved, the second user receives a notification and can run the final approval
step.

Viewing workflow history and logs

When the workflow is complete, you can use Workflow Log to view past instances when
the workflow was used to set the customer on hold.
View Workflow Logs to see history.

Requirement!
This functionality is available in Extender Levels Configurator, Customizer and Developer.

To use the Workflow console, users need to be configured as a Workflow User.

To configure the Tray Icon on the Sage 300 screens, you need to install Information Manager.

To use the icons, you need to configure the user as a Workflow User
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O/E ORDERS APPROVALS

Overview
A company wants to configure workflow using Orchid Extender to approve orders placed by
Retail Customers.

When an order is entered for a Retail customer, the order is immediately placed on hold and the cus-
tomer service manager receives an email notification. A user in Accounts must approve the order to
take it off hold.

When the order is approved, it is taken off hold automatically and the user who entered the order
receives an email notification.

When the order is rejected, a comment is entered and the requester receives an email.

The same workflow is required when they need to take off-hold orders put on hold manually.

Extender Setup key steps
This Retail O/E Approval workflow template is designed to be started automatically when a new
O/E Order is inserted for a Customer in the Retail (RTL) Customer Group. The workflow will set the order
on hold automatically.

A separate workflow to control the process to take orders Off hold starts automatically. This process is
also used for orders set on hold outside of the workflow.

In this tutorial, the customer group that requires approval is configured as a Parameter when attaching
the workflow to the Sage O/E View.

The Approver who can take the order off hold is also configured when the workflow is attached to the
Sage O/E Order view.

Add email templates "Order approved" and "Order rejected"

Configure Workflow colours: Orange to show New On-hold orders and Red for "rejected" orders.

Create a O/E Order approval Workflow and Order On hold workflow in Extender Setup > Workflow
Templates.

Workflow template - Step by step guide - OE New Retail orders on
hold
It is recommended to add the main steps as defined on the process flowchart first, and then configure
the detailed actions for each step.

Workflow Templates - Screen Guide on page 90

WORKFLOW CONFIGURATION
Template ID - Enter a descriptive name.
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The name cannot be updated after it is created

Can start manually: set to No as the workflow will start whenever an O/E order is inserted and will
be attached to O/E Order view.

Auto Delete instance when complete: Yes - as the workflow history is available in Extender Inquir-
ies.

You can set it to No while testing to view all Orders workflow on the console.

Can start multiple instances: Yes

WORKFLOW STEPS
Add 3 steps - The detailed actions for each steps will be configured below.

Check = Entry Step: If the Customer group = Retail, request approval and set the
Order on hold flag to "on hold"
Error= If the workflow has a critical error, such as the order cannot be set on hold,
the workflow will wait for a manual intervention
Complete if the workflow has had an error, can be manually completed.

PROGRESS-TO STEPS
Progress-to steps are used when a user needs to select the next Step to progress the workflow. Pro-
gress-to steps add Controls to the workflow console. If workflow screen icons are configured in
Information Manager, Progress-to steps can be run from the configured Sage 300 screen.

When the order is on hold, the O/E Offhold approval workflow will be used to manage the approval
process.

The O/E Order Insert workflow can be manually progressed if it ends up in the Error step.

Select the Error Step, add a step that a user can select: Complete

VALUES
Values are used in the workflow and saved in the workflow history.

For O/E Order Approval, the workflow will track the Order Number and Customer ID to enable drill
down and the Order total amount for reference under "Requested value" in the console.

Customer and ORDERNO: to enable drilldown - Set in the first workflow step
OrderAmount: set to the Order Total in the first step

Values are also used as variables in the workflow actions. In this example, we have configured Values
to store the App

WFCOMMENT : WFCOMMENT is used to set the default On hold reason. Set to
"Retail Order set on hold by the workflow". Text can be updated in the Values
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section of the screen without updating the rest of the workflow actions.

ACTIONS
For each step, the template includes a series of actions to match the process flow requirements. In
the A/R Customer Credit Limit approval, the most commonly used actions are configured.

For a list of actions included with ExtenderConfigurator, refer to Configurator Actions on page 136

CHECK

SetDrilldown: Set the CUSTOMER value to the current customer and the ORDERNO to the cur-
rent Order to enable drilldown to customer and order from the console.

SetDescription: This will be displayed on the console. Use {CUSTOMER}-{BILNAME}-PO:
{PONUMBER} to show the Customer number, name and the PO Number on the order.

Evaluate: Used to check if the order is a "Retail" order. Defined as an order for a customer in the
RTL Customer Group. The customer group is configured as a parameter when the workflow is
attached to the O/E Order view rather than hard coding it in the workflow.

If the Order customer group is the one configured in parameter 1 ({$1}, then approval is required.
If not, the False action is set to another action to update the status and complete the workflow, as
no approval is required, so the order is not put on hold.

AssignUser: Select {$2} as the approver is entered as Parameter 2 when the workflow is attached
to the OE Order view.

AssignColour: Enter the required colour for the console.

SetField: The Order is set to "On Hold" so that the order can be saved, but not processed further
until approved.

Tip: Make sure that the False action notifies the user that there was an issue preventing the
update.

SetField: {HOLDREASON} is set to the value {WFCOMMENT}. You can update the description in
the Values section of the workflow template.

ShowUserMessage: This is used to inform the user that the workflow has started and the order is
on hold. Use in conjunction with Evaluate {PROGRAM} to ensure the message box is only dis-
played if using a Extender screen . If a custom program running on the server inserts order, you
do not want any messages to show on the server.

SendEmail: Choose a template and the email address to use

GoToStep: Choose Wait step if approval is required so that users can Approve or Reject on the
console.

ERROR

This step has no action, as it is waiting for a User to progress the workflow.
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Use Progress To Steps to configure what steps the user can start.

Workflow template - Step by step guide - O/E orders on hold
approval
It is recommended to add the main steps as defined on the process flowchart first, and then configure
the detailed actions for each step.

Workflow Templates - Screen Guide on page 90

WORKFLOW CONFIGURATION
Template ID - Enter a descriptive name.

The name cannot be updated after it is created

Can start manually: set to No as the workflow will start whenever the ONHOLD flag is updated and
will be attached to O/E Order view, {ONHOLD} field.

Auto Delete instance when complete: Yes - as the workflow history is available in Extender Inquir-
ies.

You can set it to No while testing to view all Orders workflow on the console.

Can start multiple instances: Yes

WORKFLOW STEPS
Add 4 steps - The detailed actions for each steps will be configured below.

Check = Entry Step: If the Customer group = Retail, request approval and set the
Order on hold flag to "on hold"
Wait = Record is waiting for approval.
Off-hold = Order is approved and taken off hold
Reject = Order remains on hold and requester receives an email.

PROGRESS-TO STEPS
Progress-to steps are used when a user needs to select the next Step to progress the workflow. Pro-
gress-to steps add Controls to the workflow console. If workflow screen icons are configured in
Information Manager, Progress-to steps can be run from the configured Sage 300 screen.

For O/E Order Approval, the request can be Approved (Order taken off hold) or Rejected (Order
remains on hold and can be deleted manually)

Select the Wait Step, add 2 steps that a user can select: Off-Hold and Reject

VALUES
Values are used in the workflow and saved in the workflow history.
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For O/E Order Approval, the workflow will track the Order Number and Customer ID to enable drill
down and the Order total amount for reference.

Customer and ORDERNO: to enable drilldown - Set in the first workflow step
OrderAmount: set to the Order Total in the first step

Values are also used as variables in the workflow actions. In this example, we have configured Values
to store the App

WFCOMMENT : WFCOMMENT is used to set the default On hold reason. Set to
"Retail Order set on hold by the workflow". Text can be updated in the Values sec-
tion of the screen without updating the rest of the workflow actions.

ACTIONS
For each step, the template includes a series of actions to match the process flow requirements. In
the A/R Customer Credit Limit approval, the most commonly used actions are configured.

For a list of actions included with ExtenderConfigurator, refer to Configurator Actions on page 136

CHECK

SetDescription: This will be displayed on the console. Use {CUSTOMER}-{BILNAME}-PO:
{PONUMBER} to show the Customer number, name and the PO Number on the order.

SetDrilldown: Set the CUSTOMER value to the current customer and the ORDERNO to the cur-
rent Order to enable drilldown to customer and order from the console.

Evaluate: if the user sets the order to "off hold", ({ONHOLD} value = false), go to an action that
leaves the order on hold and notifies the user that the field can only be updated through the
workflow.

AssignUser: Select {$2} as the approver is entered as Parameter 2 when the workflow is attached
to the OE Order view.

AssignColour: Enter the required colour for the console.

SetField : The Order is set to "On Hold" so that the order can be saved, but not processed further
until approved.

Tip: Make sure that the False action notifies the user that there was an issue preventing the
update.

SetField: {HOLDREASON} is set to the value {WFCOMMENT}. You can update the description in
the Values section of the workflow template.

SendEmail: Choose a template and the email address to use

GoToStep: Choose Wait step if approval is required so that users can Approve or Reject on the
console.

WAIT
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This step has no action, as it is waiting for a User to progress the workflow.

Use Progress To Steps to configure what steps the user can start.

OFF HOLD / APPROVE

SetField: This action will set the ONHOLD flag to 0. The order will not be on hold anymore.

The True action can complete the workflow.

False Action: this means the Credit Limit wasn't updated (for example, the approver doesn't have
rights to Sage 300). Make sure this goes back to the Wait step and doesn't complete the work-
flow.

SendEmailToStarter: Select a template. The action will use the email address in the Sage 300
user profile of the user who started the workflow.

Optional, ShowUserMessage if the program is the OE1100 screen to notify the user that the order
is off-hold.

GoToStep: Go back to Wait if the field update has not been successful.

REJECT

AddParameter: Add a field: 

REJECTREASON: for user to enter a comment / reason for rejection

AskForParameters: always required after AddParameter to display the popup screen and wait
for user to enter Input.

SendEmailToStarter: Select a template. The action will use the email address in the Sage 300
user profile of the user who started the workflow.

Complete: Completes the workflow. Will be deleted from the Console if "Auto delete"is set to
Yes.

Note: You could add another step to "inform customer" and complete the workflow only when
this final step is performed.

Attach workflow to OE0520 View
Add OE Order insert workflow to {INSERT} view operation. It will start when a new order is inserted.

Add OE Order on hold workflow to the ONHOLD field. It will start whenever the Order on hold field is
updated

Note: The ONHOLD workflow will start when the field is updated on the Sage 300 screen, through
other programs using the O/E Order view, including when the field is updated in a separate workflow
template.
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In Extender Setup > View Events and Scripts, select the workflow and the entry step.

Parameter1 = Customer Group

Parameter2 = Approver User

For detailed steps, refer to View Events, Scripts & WF on page 106

Configure Information Manager
If you want to configure icons on Sage 300 screens to progress the workflow and to view workflow his-
tory, you need to configure Information Manager.

Install and activate Information Manager for your version of Sage 300.
Setup I/M Options for Extender Workflow. For details, Extender Workflow- Notes/DML/Extender
Tray

CONFIGURE ICONS ON SAGE 300 O/E SCREEN
To view the workflow history and progress active workflow from the O/E Order screen, configure
Information Manager , I/M Setup > Options > Notes/DML/Extender hotkey

As the workflow cannot be started manually, do not select an Entry Step.
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Refresh the Tray icon if you have made any changes on the IM Setup>Options in the current session
as the Tray icon reads the current setup when the company is first opened.

Tip: If you have multiple Tray icons, Close the Sage 300 desktop and re-open to refresh the con-
figuration.

Using Extender
Add orders for Retail Customers

Check that the Order is on Hold and OnHold Comment = Retail order set on hold by workflow

Note:
If you add orders for non Retail Customers, the workflow will also be started on INSERT. The workflow
goes to a Complete action, so will not be visible on the console if you select "Auto delete when com-
plete". It will be in the workflow history.

If you only want to start the workflow in some conditions and don't want to see all orders in the work-
flow history log, you need a custom script that will start the workflow when certain conditions are met.

USING THE WORKFLOW CONSOLE
Go to Extender Console, notice the workflow instance record.

Click on Values Tab to see the details.

Use history to view the steps that the workflow has been following.

Log on as a user who can approve,

click "Off Hold" on the console to approve the order.
Drill down to the O/E Order to check.

USING TRAY ICONS
Log on as a user who can approve,

Find the Order or drill down to the O/E Order from the console
Click on the Workflow icon, select Off-Hold or Reject
Enter a reason
Confirm the email is sent to the user who started the workflow.
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Requirement!
This functionality is available in Extender Levels Configurator and Developer.

This functionality requires Extender Developer.

To approve on the Remote form without logging to Sage 300 first, you need an active subscription to
the Remote Action Service. You can then configure the workflow template to use Remote Action.

To use the Workflow console, configure the user as a "Workflow User". Refer to Understanding Work-
flow Users on page 83

To use the Tray Icon on the Sage 300 screens, you need to install Information Manager, configure the
tray icons and configure the user as a "Workflow User".
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P/O REQUISITIONS AND PURCHASE ORDER APPROVAL

Overview
A company wants only certain users to approve Purchase Requisitions and Purchase Orders entered in
Sage 300 P/O Module. They configure workflow using Orchid Extender to control who can approve
Purchase Requisitions and Purchase Orders.

This P/O Approval workflow module is designed to be started automatically when Purchase Requis-
itions and Purchase Orders are posted in Sage 300. The process is similar for P/O Requisitions and
P/O Purchase Orders.

When a user posts a Requisition or a Purchase Order, the workflow sets the Requisition and Purchase
Order on hold until the request is approved.

This ensures the Requisition cannot be converted to a Purchase Order and the Purchase Order cannot
be printed or receipted.

When the Requisition is approved, the workflow converts it to a Purchase Order automatically. You can
configure the workflow template to auto-approve or if required, a new approval process can start for
the Purchase Order .

When the Requisition or Purchase order is rejected, the status is remains On Hold. Users can update
the requisition, and try to take it off-hold to submitted it for approval again.

EXTENDER SETUP KEY STEPS
To start using the P/O Approval module, you need to follow the steps below:

Configure SMTP Email settings in Extender Options

This is required for the workflow to send emails to users, that an approval is required and when a P/O is
approved or rejected.

Refer to Extender Email Tab on page 75

Configure Workflow Users

All Sage 300 users who need to approve P/O Records on the workflow console need to be set as Work-
flow Users. Extender License and Workflow Users on page 82

Check Sage 300 users email addresses
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Create Workflow User Group

Create a workflow user group called PURCHASESMGR. You can add the required Sage 300 users to that
group. Refer to Workflow User Groups on page 85 for details.

If you don't create a workflow user group, you can select a Sage 300 user as the approver. See Step 6
below.

Add Workflow colours

The P/O approval uses 2 colours: wfError* if there are any errors, and PURCHASES for regular work-
flow records on the Console.
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You can choose the colour you want for the console, as long as you create Workflow Colours with the
same names. (Workflow Colours on page 85).

Import the PO Approval.vi file

It will create 2 workflow templates, message templates and link the workflow to the PO Requisition and
PO Purchase Order Header view.

Configure the PO approval module - Print settings

In the PO Approval Print configuration table, you can configure the path where the workflow saves the
PO and PO Requisition PDF files, typically in a in a folder per vendor.

You also select the message template used to email vendors based on the AP Vendor delivery method.

The PO Approvals module prints the PO Requisition and the PO Purchase Order as a PDF Report, saved
on the server. Optionally, the workflow can email the vendor based on the AP Vendor delivery method.

To configure the Print options, go to Extender Setup, select Custom table Editor, POAPPROVALS Con-
figuration, and Load

Create a new record, set Record ID = 1.

CONFIGURATION DETAILED DESCRIPTION AND EXAMPLE

Record ID 1

Print Directory

Path where you want to save the PO Purchase Order PDF. Include {VALUE} in the
path to create a folder per vendor

Select UNC path so that all. Users can access the folder.

Example: C:\Orchid\Custom Documents\WF\PO Documents\{VALUE}

PO Report Name

Report Group and Crystal Report file name (group is from the PORPT.ini file).

Crystal Report cannot be a data pipe report

POPOR01[POPOR04.RPT]

Vendor Message
Template

POAPPROVALS.VENDORPOMSG is the default message in the module.

You can amend the default message or create a new one and change the con-
figuration.

Default Email
Address

Admin user email address to use when the Vendor’s delivery method is set to
Email or Email Contact, but there is no valid email.

Email Vendor?
Select if you want to email the vendor based on the AP Delivery method.

If the Vendor’s delivery method is set to Mail, the PDF is saved, but no email is
sent.

Requisition Print
Directory

Path where you want to save the PO Requisition PDF. Include {VALUE} in the
path to create a folder per vendor.

C:\Orchid\Custom Documents\WF\PO Requisitions\{VALUE}
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Requisition Report
Name

Report Group and Crystal Report file name (group is from the PORPT.ini file).

Crystal Report cannot be a data pipe report.

PORQN01[PORQN01.RPT]

Show Message in
Print Actions

Select to view a confirmation message on the screen after the PDF is printed and
the vendor is emailed. Useful for testing.

Generally don’t select it in production server. You can see the value where the
PDF is saved in the workflow logs.

Configure the PO approval module - User delegated amount and man-
ager

In Extender Setup > Custom Table Editor, select the POAPPROVALS.VIUSDEPT table.

Each user has a delegation of authority: Transactions below this amount do not require approval. If you
want all P/O and all Requisitions to be approved, set the value to 0.

For all users creating P/O, select their manager.

Select Custom Table Editor in Extender Setup.

Select User Dept Delegated Amt

Load

Create a new record for all users who will be creating PO Requisitions and PO. Select the delegated
amount and the Manager User ID. Below the delegated amount, the PO goes straight to the Controller
for approval, above the delegated amount, the manager needs to approve first.
Save
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Configure approving user

This setting is used for Purchase Requisitions and for Purchase Orders that are not linked to requisitions.

This is configured in View Events, Scripts and workflow

PO requisition– Parameter 1 = Sage 300 user or workflow user group who approves after the manager.

Optionally, configure module to use Remote Action in workflow tem-
plate

If you want to start using Remote Action Service and have purchased a Remote Action Subscription, you
can set the value WFUSEREMOTE = Y in the required Workflow Template.

Workflow Template PO Requisition PO Purchase Order
Default Value Use Remote Action N N
To use Remote Action in Requisition, but not in Purchase Order Y N
To use Remote Action in Purchase Order, not in requisition N Y
To use Remote Action in both Y Y
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USE REMOTE ACTION WORKFLOW TEMPLATE SCREENSHOT
Check the WFUSEREMOTE value (in the panel in the bottom right) in both workflow templates

Auto approve PO from requisitions –

This is configured in the POAPPROVALS.PO Purchase Order workflow template. It applies only to PO
Purchase Order Approval

You can set the value to N if you want a new approval process for Purchase Orders created from requis-
itions.
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Workflow template - Step by step guide
It is recommended to add the main steps as defined on the process flowchart first, and then configure
the detailed actions for each step.

This tutorial highlights details about some important workflow actions. It is not a detailed training of
each workflow action used in this template. For more details on workflow templates and actions, refer to
For details, refer to Workflow Templates - Screen Guide on page 90.

WORKFLOW CONFIGURATION
Template ID - The template name includes the Module ID for ease of deployment. The name cannot
be updated after it is created

Can start manually: set to No as the workflow will start whenever the PO on hold status changes.

Auto Delete instance when complete: Yes as the workflow history is accessible in the log.

WORKFLOW STEPS
Workflow includes 8 main steps - The main actions for each are described below:

Start- Entry Step: This determine what branch the workflow should take based on the PO /
Requisition status that is updated and whether there is a pending workflow or not. It also sets
some general values for use in the workflow console and logs. If the user tries to change the
On Hold field, the status is reset to On Hold.
StartNewOrder - When a PO or a Requisition is inserted
DeactivateOrder - When the user sets the status to OnHold , this step completes the workflow
automatically. No approval, the record remains on hold.
ResubmitOrder - When the user sets the OnHold field to "Off hold". If there is a pending work-
flow, the user is informed and the PO/ Requisition remains on hold. If there is no pending work-
flow, the PO/Requisition is printed and an email is sent. In both cases, the PO/Requisition
remains on hold.
Wait - Record is waiting for approval.
Approve - This will set the Requisition to Off hold and create a PO. If AutoApprove PO from
Requisition is set to Y, the PO is automatically approved. The Workflow creates a PDF and
emails the Vendor, if the Print Configuration table "Email Vendor" field is selected.
Reject - Rejecting user to enter a comment. The Requisition / PO remains on hold. User can
amend the details, and resubmit by setting the OnHold Flag off on the Requisition.
ErrorMessage - Used to demonstrate a suggested approach to cater for error handling in
workflow, for example if Sage security settings prevent a user from completing a workflow
action.

PROGRESS-TO STEPS
Progress-to steps are used when a user needs to select the next Step to progress the workflow. Pro-
gress-to steps add Controls to the workflow console. If workflow screen icons are configured in
Information Manager, Progress-to steps can be run from the configured Sage 300 screen.
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In the P/O Approval workflow, the request can be Approved or Rejected.

Select the Wait Step, add 2 steps that a user can select: Approve and Reject
Select the ErrorMessage Step, add 2 steps so that the Admin user can Approve or Reject.

VALUES
Values are used in the workflow and saved in the workflow history.

For PO Approval, the workflow will track the path and filename of the PDF created, the approvers,
whether the Remote Action Service is used.

ACTIONS
For each step, the template includes a series of actions to match the process flow requirements.

For a list of actions included with ExtenderConfigurator, refer to Configurator Actions on page 136

testing Extender workflow setup
The workflow starts when the PO Requisition or a Purchase Order is created. (by a user on a Sage 300
screen or by an import or a custom process using the Sage 300 Views).

Start the workflow

Log on to Sage 300 and create a new P/O Requisition. .

The workflow is started and the P/O Record is reset to "On Hold".
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Note:
Users who create requisitions need security rights to “Requisitions Manual Approval” in Sage 300
Security Group if the “Require Approval” is selected in P/O Options. If not, the PDF generated by the
workflow doesn't include any details.

Click to expand Security Group Screenshot

Approve or Reject the Purchase Order or Purchase Requisition

1. Logon to Sage 300 as a user who can approve
a. User needs to be set as a workflow user (in Extender License screen)
b. User needs to have rights to Create Purchase Orders.

2. Go to Extender Workflow > Console, notice the workflow instance record.
3. Click on Values Tab to see the details.
4. Use history to view the steps that the workflow has been following.
5. Click Approve on the Workflow Console -

Page 40 of 162 Extender Configurator Tutorials



Orchid Modules

a. This will approve the PO Requisition and create a PO
b. Send an email to the user who requested the approval.

6. View the Extender Inquiries > Workflow Details Log
a. Review the history of the Requisition and the Purchase Order.
b. Drilldown to the Purchase Order to check that the PO is ready.

7. Create another PO or Requisition and repeat steps. Choose Reject on the console.
a. This completes the workflow.
b. Amend the PO or the Requisition and de-select On Hold This restarts a workflow.
c. Approve the record on the console.
d. Review the Workflow Logs in Extender Inquiries

USING TRAY ICONS
Log on as a user who can approve and is configured as a Workflow User,

Find the Purchase Requisition or the Purchase Order or drill down from the console
Click on the Workflow icon, select Reject
Enter a reason
Confirm the email is sent to the user who started the workflow.

Software Required
Requirement!
This functionality requires Extender Developer.

To use the Workflow console, configure the user as a "Workflow User". Refer to Understanding Work-
flow Users on page 83

To use the Tray Icon on the Sage 300 screens, you need to install Information Manager, configure the
tray icons and configure the user as a "Workflow User".
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A/P PAYMENT BATCH APPROVAL

Overview
A company wants only certain users to approve A/P Payment Batches. They configure workflow using
Orchid Extender to control who can set A/P Payment Batches to "ready to post".

This A/P Payment batch workflow template is designed to be started automatically when the A/P Pay-
ment batch status is updated in Sage 300.

When a user sets the batch to Ready to post, the workflow will reset the Batch status to Check

Creation in Progress (8) until the request is approved. This ensures the batches cannot be
modified while the workflow is in progress.

When the request is approved, the batch status is set to Ready to Post and the batch is posted
automatically.

When the batch is rejected, the status is reset to Open.

The workflow updates the batch description to include Submitted or Approved to inform users.

EXTENDER SETUP KEY STEPS
To start using the AP Payment approval module, you need to follow the steps below:

Configure SMTP Email settings in Extender Options

This is required for the workflow to send emails to users, that an approval is required and when a batch is
approved or rejected.

Refer to Extender Email Tab on page 75

Configure Workflow Users

All Sage 300 users who need to approve batches on the workflow console need to be set as Workflow
Users. Extender License and Workflow Users on page 82

Check Sage 300 users email addresses
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Create Workflow User Group

Create a workflow user group called APPAYMAPPROVER. You can add the required Sage 300 users to
that group. Refer to Workflow User Groups on page 85 for details.

If you don't create a workflow user group, you can select a Sage 300 user as the approver. See Step 6
below.

Add Workflow colours

The AP Payment batch approval uses 2 colours:  URGENT if there are any errors, and ACCOUNTS for reg-
ular workflow records on the Console.
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You can choose the colour you want for the console, as long as you create Workflow Colours with the
same names. (Workflow Colours on page 85).

Import the AP Payment Batch Approval.vi file

It will create a workflow template, message templates and link the workflow to the AP Payment batch
view.

EXPAND TO VIEW DETAILED SCREENSHOTS

Create a "Workflow Template" in Extender Setup > Workflow Templates

Add message templates

To amend the message templates, refer to Message Templates on page 86
Attach the Workflow template to the AP0030 > BATCHSTAT Field

Configure the AP Payment approval module

In Extender Setup > View Events, Scripts and Workflow,
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1. Select the AP0030 view.
2. On the Workflow Tab, set the required values for your company
3. In Parameter 1, enter the Sage 300 user or Workflow User Group (e.g. APPAYMAPPROVER created

in Step 3) who can approve.
4. Set the path where to save the Batch listing Report in Parameter 2.

Workflow template - Step by step guide
It is recommended to add the main steps as defined on the process flowchart first, and then configure
the detailed actions for each step.

This tutorial highlights details about some important workflow actions. It is not a detailed training of
each workflow action used in this template. For more details on workflow templates and actions, refer to
For details, refer to Workflow Templates - Screen Guide on page 90.

WORKFLOW CONFIGURATION
Template ID - The template name includes the Module ID for ease of deployment. The name cannot
be updated after it is created

Can start manually: set to No as the workflow will start whenever the A/P Payment Batch status
changes and will be attached to the A/P Payment Batch view.

Auto Delete instance when complete: Yes as the workflow history is accessible in the log.

Can start multiple instances: Yes - If you want the workflow to behave differently if there is an
active pending workflow before a new one starts, use the "IfWorkflowExists" action.

WORKFLOW STEPS
Add 5 steps - The main actions for each are described below:

Check - Entry Step: This determine what branch the workflow should take based on the batch
status that is updated and whether there is a pending workflow or not. It also sets some gen-
eral values for use in the workflow console and logs. If the user tries to post the batch, the
status is reset to Check creation in progress
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Wait - Record is waiting for approval.
Approve - This will set the Batch to "Ready to Post" and the batch will be posted
Reject - Rejecting user to enter a comment. The batch status is reset to Open

ErrorMessage - Used to demonstrate a suggested approach to cater for error handling in
workflow, for example if Sage security settings prevent a user from completing a workflow
action.

PROGRESS-TO STEPS
Progress-to steps are used when a user needs to select the next Step to progress the workflow. Pro-
gress-to steps add Controls to the workflow console. If workflow screen icons are configured in
Information Manager, Progress-to steps can be run from the configured Sage 300 screen.

For A/P Batch approval, the request can be Approved or Rejected.

Select the Wait Step, add 2 steps that a user can select: Approve and Reject
Select the ErrorMessage Step, add 2 steps so that the Admin user can Approve or Reject.

VALUES
Values are used in the workflow and saved in the workflow history.

For A/P Batch Approval, the workflow will track the Batch Number to enable drill down

BATCHNO: to enable drilldown - Set in the first workflow step
APPAYMRPTPATH: stores the filepath and filename of the batch listing PDF so that it can be
attached to an email.

ACTIONS
For each step, the template includes a series of actions to match the process flow requirements.

For a list of actions included with ExtenderConfigurator, refer to Configurator Actions on page 136

CHECK

SetDrilldown: Set the CNTBTCH value to the current Batch Number to enable drilldown from the
console

Evaluate: If the requested Batch Status is 7 / Ready to Post, Approval is required. If not 7, go to a
step that sets a WFCOMMENT Value, Sets description and then complete the workflow imme-
diately.

AssignUser: Enter the appropriate user who can set A/P Payment batches to Ready to Post

AssignColour: Enter the required colour for the workflow console.

GenerateAPPaymBatchListing: This action prints the AP Batch listing report to PDF. The file
is saved into the path configured in Parameter 4, the filepath and file name are stored in a work-
flow value defined in Parameter 2.
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Tip: To modify the report used, copy the default APCBTCLZ.rpt file, update the report as
required and change the Report name configured in Parameter 3. The new report must have
the same parameters as the default batch listing report.

SetField: Used to restore the A/P Payment batch status to Check creation in progress

until approved. - This prevents the batch from being posted and updated while a workflow is
pending.

It is also used to update the Batch Description to Submitted-Original Batch Descrip-

tion so users can quickly scan the batch listing and view submitted and approved batches.

Tip: Make sure that the False action notifies the user that there was an issue preventing the
update. If SetField is false, next action is SetValue to update the WFCRITICALERROR value, and
then go to ErrorMessage Step.

SetDescription: This will be displayed on the console. Use {BATCHDESC}to show the batch
description.

SendEmail: Choose a template and the User / User group or email address to use

GoToStep: Choose Wait step if approval is required so that users can Approve or Reject on the
console.

Complete: Action to complete the workflow, Selected If Evaluate is false, Action = Complete
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Tip: If you want to send email notification to the approver, create a message template and add
a SendEmail action.

WAIT

This step has no action, as it is waiting for a User to progress the workflow.

APPROVE

AddParameter: Optionally add a field if you want the user to enter a comment: 

APPRCOMMENT: for approver to enter a comment

AskForParameters: always required after AddParameter to display the popup screen and wait
for user to enter Input.

SetField: This action will set the Batch status to 7, Ready to post.

The True action can complete the workflow.

False Action: this means the batch status wasn't updated (for example, the approver doesn't have
rights to Sage 300). Make sure this goes back to the Wait step and doesn't complete the work-
flow. False Action could be "SendEmail" to an Admin user and then go back to "Wait" step.

SendEmailToStarter: Select a template. The action will use the email address in the Sage 300
user profile of the user who started the workflow.

GoToStep: Go back to Wait if the field update has not been successful.

REJECT

AddParameter: Add a field: 

REJECTREASON: for user to enter a comment / reason for rejection

AskForParameters: always required after AddParameter to display the popup screen and wait
for user to enter Input.

SetField: This action will set the Batch status to 1, Open.

SendEmailToStarter: Select a template. The action will use the email address in the Sage 300
user profile of the user who started the workflow.

Complete: Completes the workflow. Will be deleted from the Console if "Auto delete"is set to
Yes.

If a user tries to set the batch to "Ready to post" again, a new workflow will start.

ERRORMESSAGE

SendEmail: Select a User and a template. The action will use the email address in the Sage 300
user profile of the user who started the workflow.
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Selected template to include {WFCRITICALERROR} value. Value updated in the workflow with
details of the error.

testing Extender workflow setup
The workflow starts when the A/P Payment Batch Status is updated (by a user on a Sage 300 screen or by
an import or a custom process using the Sage 300 Views).

Start the workflow

Log on to Sage 300 and set an A/P Payment batch to "Ready to Post".

The workflow is started and the batch status is reset to "Check creation in progress".

Approve or Reject the A/P Payment Batch

1. Logon to Sage 300 as a user who can approve
a. User needs to be set as a workflow user (in Extender License screen)
b. User needs rights to post an AP Payment batch in Sage 300

.
2. Go to Extender Workflow > Console, notice the workflow instance record.
3. Click on Values Tab to see the details.
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4. Use history to view the steps that the workflow has been following.
5. Click Approve on the Workflow Console -

a. This will post the batch and
b. Send an email to the user who requested the approval.

6. View the Extender Inquiries > Workflow Details Log
a. Review the history of the batch being set to "Ready to Post" and approved.
b. Drilldown to the AP Payment batch to check that the batch is posted

7. Create another batch and repeat steps. Choose Reject on the console.
a. This sets the batch to Open again.
b. Amend the batch and set Ready to Post again.
c. Approve the batch on the console.
d. Review the Workflow Logs in Extender Inquiries

Repeat the steps

Optionally, Configure Information Manager
If you want to configure icons on Sage 300 screens to progress the workflow and to view workflow his-
tory, you need to configure Information Manager.

Install and activate Information Manager for your version of Sage 300.
Setup I/M Options for Extender Workflow. For details, Extender Workflow- Notes/DML/Extender
Tray

CONFIGURE ICONS ON SAGE 300 A/P BATCH SCREEN
To view the workflow history and progress active workflow from the AP Payment /screen, configure
Information Manager , I/M Setup > Options > Notes/DML/Extender hotkey

As the workflow cannot be started manually, do not select an Entry Step.
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A/P Payment Batch workflow on A/P Payment batch screen

The A/P Payment batch view has a multi-part key, including the Batch Type and the Batch Number.
The workflow key is set to PY,Batch number, so the Information Manager configuration needs to
include 2 fields as shown below.

Field 1 should be set to "PY" (with quotes) and field 2 set to BATCH NUMBER.

Refresh the Tray icon if you have made any changes on the IM Setup>Options in the current session as
the Tray icon reads the current setup when the company is first opened.

Tip: If you have multiple Tray icons, Close the Sage 300 desktop and re-open to refresh the con-
figuration.

USING TRAY ICONS
Log on as a user who can approve and is configured as a Workflow User,

Find the A/P Payment Batch or drill down from the console
Click on the Workflow icon, select Reject
Enter a reason
Confirm the email is sent to the user who started the workflow.
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Software Required
Requirement!
This functionality is available in Extender Levels Configurator and Developer.

To use the Workflow console, configure the user as a "Workflow User". Refer to Understanding Work-
flow Users on page 83

To use the Tray Icon on the Sage 300 screens, you need to install Information Manager, configure the
tray icons and configure the user as a "Workflow User".

Using with Remote Action Service
If you want to use the Remote Action module to approve records outside of Sage 300, you need to down-
load and install the Remote Action Module on the Orchid website through your Sage 300 partner.

You can then use the AP Approval Extender module below.
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VENDOR ALERT MANUAL WORKFLOW

Overview
Purchasing team needs the ability to send alerts to Operations team about certain vendors.

In some cases, they just want to send an email notification. In other examples, they would like to track
that the operations team has seen the alert on the console.

Extender Setup key steps
To achieve the requirement, we will create a workflow template that can be manually started and con-
figure an icon on the A/P Vendor screen.

Add Workflow Users - Understanding Workflow Users on page 83
Create a "Workflow Template" in Extender Setup > Workflow Templates : Vendor
manual alert
Add Information Manager Configuration to start the Extender Workflow.

Workflow template - Step by step guide
WORKFLOW CONFIGURATION

Template ID - Enter a descriptive name. The name cannot be updated after it is created - This tutorial
refers to a one-step workflow.

Can start manually: set to Yes

Note: You need to configure what screen the workflow can be started on in I/M Options >
Notes/DML/Extender Tray setup.

Auto Delete instance when complete: Yes

Can start multiple instances: No with Message- to ensure the first request is completed before a
new one starts.

It is recommended to add the main steps as defined on the process flowchart first, and then configure
the detailed actions for each step.

For more details. Workflow Templates - Screen Guide on page 90

WORKFLOW STEPS
Add 1 step - The detailed actions for each steps will be configured below.

Send Comment: Entry Step. This steps also completes the workflow.
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Note: If you want the assigned user to confirm that they have seen the alert, create another 2
steps, "Wait" and "Complete".

PROGRESS-TO STEPS
Progress-to steps are used when a user needs to select the next Step to progress the workflow. Pro-
gress-to steps add Controls to the workflow console. If workflow screen icons are configured in
Information Manager, Progress-to steps can be run from the configured Sage 300 screen.

In this example, if you are doing a 2-step alert workflow, where the user needs to complete the work-
flow,

Select the Send Info Step, add the "Complete" step as a Progress-to step.

VALUES
Values are used in the workflow and saved in the workflow history.

For Vendor Alert manual workflow, the workflow will track the Vendor ID to enable drill down, cus-
tom description fields and Approvers.

ACTIONS
For each step, the template includes a series of actions to match the process flow requirements. In
the A/R customer on hold manual workflow, some of the key actions are described in this tutorial.

For a list of actions included with ExtenderConfigurator, refer to Configurator Actions on page 136

REQUEST INFO

AddParameter: Add required fields: 

VENDORDELAY- text(size=100) - User can enter comment
AssignedUSER - user type - when using the workflow, prompt to select the user
to assign the workflow / send the alert to.

AskForParameters: always required after AddParameter to display the popup screen and wait
for user to enter Input.

GoToStep: Go back to Wait if the field update has not been successful.

SetValue: {VIEWID} - AP0015 for A/P Vendor This is required for a manual workflow to attach the
workflow to a Sage 300 View. View fields are now available in the workflow actions and in mes-
sage templates.

SetDrilldown: Set the VENDOR value to the current Vendor {VENDORID} to enable drilldown
from the console

AssignUser: Choose the {AssignedUSER} parameter name defined above.
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Or you can enter the appropriate user If you want to hardcode the user.
If you can create a user group called APAPPROVER, you can select that group.

SetStatus: Set the workflow status to "VendorAlert"

SetDescription: This will be displayed on the console. Use {VENDNAME} to show the vendor
name.

SendEmail: Choose a template and the email address/user / user group to use -

In this example, use {CURUSER} to email the user assigned to the workflow.
Or you can email the workflow user group created APAPPROVER.

Final Action: 

Complete: Set the final action to "Complete" if you want to complete the work-
flow in one step.
GoToStep: Choose Wait step if you want the assigned user to confirm they have
seen the alert.

Note: If you want the assigned user to confirm that they have seen the alert, create another 2
steps, "Wait" and "Complete".

WAIT

The Wait steps have no action, as it is waiting for a User to progress the workflow.

COMPLETE

Complete Completes the workflow. Will be deleted from the Console if "Auto delete"is set to
Yes.

Attach workflow to AP Vendor screen
To start the workflow manually, you don't need to add it to Extender Setup > View Events and Scripts.

Instead, you add the configuration in I/M Options > Notes/DML/Extender Tray setup.

If you want to configure icons on Sage 300 screens to progress the workflow and to view workflow his-
tory, you need to configure Information Manager.

Install and activate Information Manager for your version of Sage 300.
Setup I/M Options for Extender Workflow. For details, Extender Workflow- Notes/DML/Extender
Tray
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Select RotoID AP1200 for A/P Vendor.

Field Label: Vendor Number.

Using Extender workflow to start the AP Vendor manual workflow

Use Icon on A/P Vendor screen to send an alert

Enter a comment when prompted.

The assigned user receives a notification and can complete the workflow in the console, confirming they
have seen the notification.

Viewing workflow history and logs

When the workflow is complete, you can use Workflow Log to view past instances when
the workflow was used to send detailed comment about a customer.
View Workflow Logs to see history.

Requirement!
This functionality is available in Extender Levels Configurator, Customizer and Developer.

To use the Workflow console, users need to be configured as a Workflow User.

To configure the Tray Icon on the Sage 300 screens, you need to install Information Manager.

To use the icons, you need to configure the user as a Workflow User
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I/C OPTIONS NOTIFICATION

Overview
A company wants to configure workflow using Orchid Extender to notify a user when the Serials Num-
ber of Days expires. The user needs to acknowledge that they have seen the notification.

Refer to Flowchart below.

EXTENDER SETUP KEY STEPS
This I/C Option workflow template is designed to be started automatically when the Serials-Days to
Expiry is updated in Sage 300. This workflow doesn't require approval of the change. It notifies a user,
who needs to complete the workflow to acknowledge they have seen the notification.

Create a "Workflow Template" in Extender Setup > Workflow Templates
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Workflow template - Step by step guide
It is recommended to add the main steps as defined on the process flowchart first, and then configure
the detailed actions for each step.

For details, refer to Workflow Templates - Screen Guide on page 90

WORKFLOW CONFIGURATION
Template ID - Enter a descriptive name.

The name cannot be updated after it is created

Can start manually: set to No as the workflow will start whenever the field changes and will be
attached to the I/C Options view.

Auto Delete instance when complete: Yes, as the workflow history is accessible in the Log.

Can start multiple instances: Yes - If you want the workflow to behave differently if there is an
active pending workflow before a new one starts, use the "IfWorkflowExists" action.

WORKFLOW STEPS
Add 3 steps - The detailed actions for each steps will be configured below.

Start- Entry Step. This will start the workflow whenever the field the workflow is
attached to is updated.
Wait - Record is waiting for workflow to be completed.
Complete- User to complete the workflow
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PROGRESS-TO STEPS
Progress-to steps are used when a user needs to select the next Step to progress the workflow. Pro-
gress-to steps add Controls to the workflow console. If workflow screen icons are configured in
Information Manager, Progress-to steps can be run from the configured Sage 300 screen.

For I/C Options, the user can complete the workflow, confirming that they have seen the notification
of the change. .

Select the Wait Step, add 1 step that a user can select: Complete

VALUES
Values are used in the workflow and saved in the workflow history.

For I/C Option notification workflow, the original value is tracked in the workflow.

ACTIONS
For each step, the template includes a series of actions to match the process flow requirements.

For a list of actions included with ExtenderConfigurator, refer to Configurator Actions on page 136

START

SetDescription: Set the description based on the field you are notifying.

SetStatus: Type an appropriate Status, will be used on the console and the workflow logs.
e.g. Notified

AssignUser: Set to {$1} - The user will be configured as a parameter when the workflow is
attached to I/C Options View.

AssignColour: Enter the required colour (optional)

SendEmail: Choose a template and the Sage 300 user. The email address will be from the User
profile in Sage 300.

GoToStep: Choose Wait step to wait for the user to complete the workflow and clear the noti-
fication.

WAIT

This step has no action, as it is waiting for a User to progress the workflow.

COMPLETE

SetStatus: Enter a relevant description to indicate the user has seen the notification.

Complete: Complete workflow.
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Attach workflow to IC0380 {SEXPDAYS} Field
The workflow template is attached to the I/C Options (IC0380) so that the workflow starts automatically
when the " Serials-Days to Expiry" field is updated.

DETAILED STEPS
Extender Setup > View Events and Scripts.

For detailed steps, refer to View Events, Scripts & WF on page 106

Select IC0380 view, on the Workflow Tab, select {SEXPDAYS} the I/C Options Workflow and "Start" as
the Entry step.

Enter the name of the Sage 300 User to notify in Parameter 1.

Tip:
You can also use up to 4 parameters configured in View Events and Scripts > Workflow Tab. Para-
meters need to be used in the Workflow template using SetValue.

Using Parameters in Workflow

Configure Information Manager
Optionally, you can configure the Information Manager tray to display Extender buttons on relevant
Sage 300 screens.

Refer to: Extender Workflow- Notes/DML/Extender Tray

Testing Sage 300 workflow setup
The workflow is started when the I/C Options > Serials-Days to Expiry field is updated (by a user on a
Sage 300 screen or by an import or a custom process using the Sage 300 Views).

Important! You need to close the Information Manager Tray to update I/C Options.
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USING THE WORKFLOW CONSOLE
Go to Extender Console, notice the workflow instance record.

Click on Values Tab to see the details.

Use history to view the steps that the workflow has been following.

Log on as a user who can approve,

click Approve on the console.
Confirm the credit limit to approve and a comment
Drill down to the AR Customer to check.

Requirement!
This functionality is available in Extender Levels Configurator and Developer.

This functionality requires Extender Developer.

To use the Workflow console, configure the user as a "Workflow User". Refer to Understanding Work-
flow Users on page 83

To use the Tray Icon on the Sage 300 screens, you need to install Information Manager, configure the
tray icons and configure the user as a "Workflow User".

Extender Configurator Tutorials Page 61 of 162



Page 62 of 162 Extender Configurator Tutorials

This page intentionally left blank.



Orchid Modules

Setting Up Extender Workflow
Workflows can be configured to approve new records, approve field changes in Sage 300 or start auto-
matically a series of actions to alert users when something happens in Sage 300.

BEFORE YOU START
Step 1: Draw a diagram of the workflow you require.

Step 2: Assign the Visual Process Flow to follow the key steps.

Refer to Assigning Visual Process Flows
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SETUP WORKFLOW IN EXTENDER

Step 1. Use the icons in the Extender Setup folder to configure
workflow:

Step 2. Setup Extender Adding Security on page 71 in Sage 300
Administrative Services.

Step 3. Configure Workflow Users.
Refer to Extender License and Workflow Users on page 82

Step 4. If you want the workflow to send emails,
Configure Extender emails . Refer to Options on page 73
Configure Message Templates.

Step 5. Create Workflow User Groups

Step 6. Configure Workflow colors

Step 7. Add Workflow Templates
Workflow Templates - Screen Guide on page 90

APPLY WORKFLOW TO THE REQUIRED SAGE 300 VIEWS.
In most cases, the workflow is configured to start automatically when a record is updated in Sage 300.

Refer to View Events, Scripts & WF on page 106

A workflow can be started automatically
when a view field is updated – you attach the workflow template to a View field.
the insert/update/upsert/delete operation on a Sage 300 view - the workflow template
is attached to a view operation.
by a Python script run on the Sage 300 desktop or attached to a Sage view.
by a Python script run using Process Scheduler.

A workflow can be started manually
You can start a workflow manually from an icon on a Sage 300 screen.

Page 64 of 162 Setting Up Extender Workflow



Orchid Modules

The logged-on user has to be configured as a Workflow User. For details refer to Understanding Work-
flow Users on page 83,

You configure which screens can start workflow in Information Manager Setup > I/M Options.

Refer to Extender Workflow- Notes/DML/Extender Tray .

OPTIONALLY, ADD ICONS TO SAGE 300 SCREENS
You can configure Information Manager to add icons to Sage 300 screens to progress workflow and view
workflow history.

Configure Information Manager to enable Workflow icons on Sage 300 screens

Install and Activate Information Manager
In I/M Options, Notes/DML/Extender Tray, add configuration rows to add workflow
icons toSage 300 screens
Refresh the Tray

INSTALLING EXTENDER

Installation Steps
Extender is installed by executing the EXE program downloaded for installation. InstallShield will execute
and guide you through the installation steps, including whether to install documentation.

Before you Start

Download the program installer for the version of Sage 300 you are running (only available in the
Partner area of the Orchid website).
Before installing Extender, ensure that all users have logged out of Sage 300.

Installing the files

Log on to the server where Sage 300 is installed as a user with full administrator rights.
Run the previously downloaded InstallShield for the module.
If prompted to re-boot, then do so.

Tip:
Programs are installed in the Sage 300 program folder, in the VIXXA subfolder, where VI is the 2-letter
code for the Orchid module and XX depends on the Sage 300 version you are running:

Example: VI68A for Extender version 2021, VI69A for Version 2022, VI71A for Version 2024.
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Note: REGACC is run automatically as part of the installation process. If some files are locked during
the installation, the re-boot is required to unlock all files and complete the installation.

Important! If you install Sage 300 on each workstation, as well as the server, then you must do the
same with Extender. In this case, repeat the above steps for each workstation.

Activate Extender
Activate Extender in Sage 300 Administrative Services > Data Activation.

For information on activating modules, refer to the Sage 300 System Manager online Help (choose the
Help menu on the Sage 300 desktop) or review the chapter, Setting Up Security, in the System Manager
Administrator Guide

License Details
To start using Extender, you need a valid serial number and license file.

If you don't have a valid license for Extender, you only see the License screen.

Enter License Details

The installation doesn't require a serial number anymore. You enter the serial number and activation
code in the License screen.

Note: This applies to Sage 300 versions 2019 and above. You need a serial number to install
an older version.

After you install the software, you need to activate Extender in one company using Sage 300 Admin-
istrative Services > Data Activation.

There are two options to enter the license details:

USE A 30 DAY TRIAL LICENSE FILE
To generate a 30-day trial license file, enter the serial number provided for your module and Save the
details.

AFTER PURCHASING A SUBSCRIPTION OR A PERPETUAL LICENSE
If you have purchased the module, enter the serial number and activation code provided by your
Sage 300 business partner.

Note: The license applies to all the Sage 300 databases for the same installation. You only need to
enter the license details in one company.

Refer to Extender License Screen on the facing page for details on entering Activation Code.

Tip: If installing with a 30 day grace period, additional re-installations will not extend the grace period.
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Upgrading from a prior version
1. Download the new version install program from the Orchid website (Business Partner access only)
2. Obtain the serial number and activation code for the new version
3. Backup your existing database and programs as per Sage Upgrade guidelines
4. Execute the EXE program downloaded (as above for a new install).
5. In Sage 300 / Administrative Services / Data Activation, Activate Extender
6. Enter serial number and activation code in the Extender License screen. (as above)

Note: Depending on the Extender configuration in the database, you may get prompted to restart the
Sage desktop.

All Extender customizations can now be tested. You don't need to upgrade individual Extender scripts.

Minimum Requirements
You need to use the same version for the core Sage 300 modules and Extender. For example, Extender
version 2024 requires Sage 300 System Manager version 2024.

Additional specific Sage 300 modules may be required to enable all functionality. Refer to Orchid Sys-
tems's website for details ( https://www.orchid.systems).

EXTENDER LICENSE SCREEN
To start using Extender, you need a valid serial number and license file.

If you don't have a valid license for Extender, you only see the License screen.

License screen
You use the Extender license screen to enter serial number and activation code.

When to use: 
After a new installation or an upgrade to a newer version of Sage 300.
After a subscription renewal, enter the activation code with the new expiry date.
View the components of the Orchid module you are licensed for.

How to use: 
Enter the license details, click the Add button to create the license file.
Restart the Sage desktop to enable the new license.
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Workflow Users

You also use the Extender license screen to maintain Extender Workflow users.

For details, refer to Extender License and Workflow Users on page 82

30-day Trial Licence

If you don't have an activation code for Extender, you can create a 30-day trial license.

In the License screen, enter a serial number for the module, Sage 300 version and edition you are run-
ning.

Click the Add button. This create a 30-day trial license.

Tip: If you install a 30-day trial, enter a valid activation code before the trial expiry date to continue
using the application.

Page 68 of 162 Setting Up Extender Workflow



Orchid Modules

Extender license screen details
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Subscription Licenses Expiry Date

You can check the subscription expiry date and enter a new activation code after a subscription renewal
is processed.

Subscription licenses have an expiry date. To continue using Extender, you will need to renew the sub-
scription and enter a new Activation code in the module License screen before the expiry date.

Contact your Sage 300 Business Partner for details.

Note: In the four weeks before the expiry date, users receive a warning message when logging into
Sage 300 (weekly for the first three weeks and daily in the last week). If you don't renew before the
expiry date, the software will become read-only.

Extender and Orchid modules web screens
Web screens for Orchid modules rely on Extender for ease of deployment and maintenance. To run the
Orchid Module web screens, you need to install and activate Extender, even if you don't have a license
for Extender.
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Without a license, you will not have access to Extender functionality, you can only run the web screens
for the modules that you are entitled. For details on web screens, refer to Installing EFT Web Screens.

Troubleshooting Activation Code
When saving the license information, the following problems may be encountered:

Activation code Invalid – verify the registered company name (displayed during installation) and serial
number entered match the details supplied to Orchid Systems when an activation code was requested.

Invalid serial number – the entered serial number is not valid for this product, Sage 300 version and edi-
tion.

Important! If the Sage 300 Version or Edition change, a new Serial Number and activation

code must be requested from Orchid Systems.

If the company name registered with Sage changes, a new Activation Code must be requested from
Orchid Systems.

Refer to detailed troubleshooting tips in Troubleshooting Activation Code,

Activation code and available functionality
Depending on the components you are licensed to use, some features described here may not be avail-
able for you to use. Some functionality of Extender is only active if you have purchased the required mod-
ule component.

The license screen displays what components of the Extender module are included in the activation
code.

ADDING SECURITY
If your Sage 300 system requires user passwords and security profiles, you need to create Security
Groups and assign user security to Extender. All other setup options can only be run by the ADMIN user.

For information on activating security and setting up security groups, refer to the System Manager
online Help (choose the Help menu on the Sage 300 desktop) or review the chapter, “Setting Up Secur-
ity,” in the System Manager Administrator Guide (or the System Manager Setup Guide if you are using
Sage 300 Standard).

Assigning Extender security
Using the Security Groups form in the Administrative Services folder, you can assign the following secur-
ity tasks to Extender.

Security Group Description
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View Logs Can view logs populated by Extender

Edit Scripts Can Edit and Run Extender scripts using VI1001 and VI1008.

Run Scripts
Can Run scripts from the Extender Setup screens.

Note: You don't need to give Run Scripts Security rights for Extender
View or UI scripts to be active.

Access Modules Screens Can import and export modules

Access Setup Screens

Access to all setup screens, including Custom Tables and configuring
Email Messages.

Note:
This includes the following Security Groups: Access Modules Screens,
Configure Events and Run Scripts -

To Edit Scripts, you need to select the "Edit scripts" group too.

Configure Events Can attach existing events to View and view fields.

View Custom Table
records

Can access Extender's Custom Table Editor to view records in all custom
tables.

Note: You don't need access to the Custom Table Editor for a script to
use the custom table values in an Extender script or an
Information Manager Note.

Edit Custom Table
Records

Can access Extender's Custom table Editor to view, add, edit and delete
records in all custom tables.

This security group only controls access to Extender's Custom Table
Editor This doesn't control the rights to View/Add/Edit or Delete records
in the custom tables. If you are using a custom script to maintain custom
table records, you need to make sure that only the relevant users have
access to the custom script.

View All Workflows
User can view all workflow instances in the Console (whether
they are assigned to it or not).

Modify All Workflows

User can reassign workflows. This is required to use the default Reassign
Action or the Delete button on the Workflow Console, even if the work-
flow is assigned to the user.

User can progress all workflows, even when not assigned to a workflow.

View Workflow Logs
User can view the workflow logs for all workflows using Work-
flow Inquiry screens.

Configure Workflow
Configure Workflow templates in Extender Setup. you have
read/write access to Workflow Templates, User Groups, Work-
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flow Colours, Message Templates

Extender security and workflow users

Note:
A Workflow User license is required for each user who needs to access Extender Workflow func-
tionality:

Extender Workflow Console: The console lets users monitor workflow instances, drill

down for detail, and progress workflows that have been assigned to them.

Start or progress Extender Workflow using the Icons on Sage 300 screens.

View workflow history using configured icons on Sage 300 screens.

Access Extender Audit Logs via icons configured on Sage 300 screens to view the

detailed history of logged records.

Custom Table Security
If you need more granular security on custom tables, where some users can view records in certain cus-
tom tables, and edit in other tables, for example, you cannot use the default Custom Table Editor. You
would need to write a custom script that controls who can view/add/edit/delete records in the various
tables.

OPTIONS
Use this form to setup Extender Options to log user sign in and configure SMTP server details to email
from Extender

Options Tab

Log User Sign in : Yes or No.

Select Yes if you want Extender to create a log entry for each user as they log into the Sage 300 com-
pany. The date and time, user id and Machine address where the user logged in from is recorded in the
log.

Select No if you do not want to log the log-in activity.
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Python Version

By default, Extender is now configured to use Python 3.8.8.

Refer to Python version for details.

Email Tab: enter Email server details
For details, refer to Extender Email Tab on the facing page

Email Server : smtp.domain.com:587 Enter the details of the SMTP Server you want to email from.
The default port is generally port 587 with TLS.

Tip: You can specify a port number after filling in the email server details. After the email
server name, enter “:xx” i.e. colon xx where xx is the port number required. Example: smt-
p.domain.com:587

Email User and Email Password: Enter a correct combination of Email user and password

Note: If using multi-factor authentication and App password, enter the App password you
create in he Email Password field. Refer to Using Orchid Modules with Office365 and Multi-
Factor Authentication

Email Comes From: Enter the email address to be used when sending email.

Note: Depending on the SMTP server you use, this address may need to match

the one you enter in the Username field, or may not work unless you set up an

email alias. Consult your SMTP server documentation for details about sending

email.

Updates Tab

NOTIFY ME WHEN THERE ARE NEW UPDATES IN EXTENDER
Users can now "subscribe" to notifications of updates.

By Default, this option is not selected for end-user serial numbers

The check is stored in the registry and it applies to this Windows user on this computer.

If selected, when starting Sage it will check if there are product updates available for Extender

If there is a new update, and the user hasn't previously been notified of it, then the Options screen
will open automatically on the Updates tab and display details of the new updates.
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Tip: The “administrator” or “super user” or “owner” of Sage 300 should have this option

turned on. All other users should have it turned off.

CHECK FOR UPDATES AND SUPPORT REQUESTS
You can use "Check for Updates" button to view the list of new features and fixes.

To facilitate support, please include the Version and Product Updates you are running when report-
ing any issues.

Updates are available to be downloaded from the partner area of the Orchid website Product down-
loads. 

EXTENDER EMAIL TAB
The Email tab lets you define your email server. When you fill in the email option on the Extender
Options, it will email directly to your email server using the selected service. Since October 2022, in the
latest product updates for Sage 300 versions 2020 and above, you can email documents using 2 meth-
ods, SMTP or Microsoft Graph.

Email Service

SMTP (Simple Mail Transfer Protocol). You can use your own SMTP server, or an
SMTP service.

Example: SMTP Email Examples on page 77

Microsoft Graph. This service sends email via Microsoft Office 365. It is generally used
when SMTP Basic authentication is not enabled in Office 365.

Refer to Office 365 and Microsoft Graph

If you don't fill in the SMTP Details, Extender cannot send emails.

Email Field details
Select the Service you want to use to email: 

Basic Authentication SMTP:

Email Server : smtp.domain.com:587 Enter the details of the SMTP Server you want to
email from. The default port is generally port 587 with TLS.
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Tip: You can specify a port number after filling in the email server details. After the
email server name, enter “:xx” i.e. colon xx where xx is the port number
required. Example: smtp.domain.com:587

Email User and Email Password: Enter a correct combination of Email user and pass-

word

Note: If using multi-factor authentication and App password, enter the App pass-
word you create in he Email Password field. Refer to Using Orchid Modules with
Office365 and Multi-Factor Authentication

Email Comes From: Enter the email address to be used when sending email.

Note: Depending on the SMTP server you use, this address may need to

match the one you enter in the Username field, or may not work unless

you set up an email alias. Consult your SMTP server documentation for

details about sending email.

Microsoft Graph:

This service sends email via Microsoft Office 365 where basic authentication is not enabled to use SMTP.

Refer to Office 365 and Microsoft Graph

Tenant ID. Enter the tenant ID (alternatively called the directory ID) from your Microsoft 365
account.

Client ID. Enter the client ID (alternatively called the application ID) from your Microsoft 365
account.

Client Secret. Enter the client secret from your Microsoft 365 account.

Tip: This is actually the secret value, not the one called Secret ID. It is the one that
you only see once when you first create the client secret.

From Email Address. Enter the email address to be used when sending email.

Examples
Refer to the examples below for detailed settings with commonly used mail providers, such as Office 365
and Gmail.

Example: SMTP Email Examples on the facing page
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Test Email Configuration
You can use the "Send Test Email..." to check your email settings. You will be prompted to enter an email
address to send the test email to.

Tip: Test sending to an email address in the same domain as your SMTP Server and one out-
side of your domain.

Tip: CC doesn't work when testing. Even if you configure a CC address in the

Email Tab,, the test email is only sent to the email address you enter when testing.

Troubleshooting Sending emails
Email Troubleshooting on page 80

SMTP Email Examples

Email with Office 365

Using Office 365 and MFA

Although Orchid modules don't support 2-step authentication directly, you don't need to turn off MFA
to use email using SMTP or DML with SharePoint integration. If you enable MFA, you can use it for all
applications that support it.

To use Office 365 to email from Orchid modules and to use Document Management Link and SharePoint
integration, users need to create an APP password for use in the Orchid module, as supported by
Microsoft. 

For details, refer to Using Orchid Modules with Office365 and Multi-Factor Authentication

Configure Email when using Office 365
When using Office 365 to email, basic SMTP authentication is disabled by default and you need to use
Microsoft Graph as the email service.

Refer to Office 365 and Microsoft Graph
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Note:
The details below are left in the documentation if your Office 365 setup supports basic
SMTP Authentication and App Passwords.

Email Server -> smtp.office365.com:587

Email User -> username@samplecompany.com

Email Password -> Enter Password

If using Multi-factor Authentication and App Password, enter the App passwordl.

For details, see Using Orchid Modules with Office365 and Multi-Factor Authentication

Encryption: TLS

TLS Version

You don't select a specific TLS version. Orchid uses the .Net SmtpClient class to send emails.
The SMTP Client uses the protocol configured on the operating system, based on the
.NET version installed.

The email function supports Ssl3, Tls1.0, Tls1.1, Tls1.2 and Tls1.3.

Microsoft has recently stopped support for TLS1.0 and TLS1.1. Support for TLS 1.2 was
added to Orchid modules in April 2020 and applies to Sage 300 versions 2018 and above.

Important! If you have any issues emailing, please ensure you download and install the
latest product update for your Sage 300 version.

Useful Links

Here is a link to Microsoft documentation on how to allow applications to send email via Office365.
http://technet.microsoft.com/en-us/library/dn554323.aspx

Using Gmail

Since May 2022, you cannot disable 2-step authentication in the Gmail settings and you need to use App
Password.

Email Server: smtp.gmail.com:587

Email User: username@gmail.com

Email Password: App password you create for the user emailing.

Encryption: TLS
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Note: In some older versions of Orchid modules, for Google mail to be setup in

Outlook/other email application/device (as recipient in CC/BCC), the Google email setting

has to have the option of enable POP/IMAP ticked.

When using any other email that has Transport Layer Security (TLS) encryption along with SMTP, you
can prefix the email server field with “TLS:”.

For eg. TLS:securemail.server.net

Using SendGrid

IF USING SENDGRID
Orchid module Email configuration using SendGrid:

Email Server -> smtp:sendgrid.net:587

Email User -> apikey

Email Password -> Enter Password

Encryption: TLS

E-Email Comes From -> the email address associated with the Sendgrid account
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Here is a link to SendGrid documentation on integrating with the SMTP API

Sendgrid: integrating-with-the-smtp-api

Here is a link on How to send email using the SMTP Relay

SendGrid smtp guide

Using Hotmail

CONFIGURE EMAIL WHEN USING HOTMAIL OR MICROSOFT OUTLOOK.COM
Email Server -> smtp.live.com:587

Email User -> username@hotmail.com

Email Password -> Enter Password

Encryption: TLS

Email Troubleshooting

Failure sending mail

If you get the error message “Failure sending mail” – check that you have entered the correct details in

The E-mail server field
The correct combination of email user/password/comes from fields. The combination and number
of these fields that are required depends on the configuration of the email server
The correct encryption method is selected

Port

If the default port for email (25) is not in use, ensure the port is included in the Email server field
separated by a semi-colon (:). For example smtp.office365.com:587 if port “587” is being used for
e-mail.

Legacy Authentication

If you are using MFA and App password in Office 365, but are still receiving errors when testing the
SMTP email, ensure that Legacy Authentication is not blocked. Refer to Office365 and Legacy Authentic-
ation.

TLS Version

You don't select a specific TLS version. Orchid uses the .Net SmtpClient class to send emails. The
SMTP Client uses the protocol configured on the operating system, based on the .NET version installed.

The email function supports Ssl3, Tls1.0, Tls1.1, Tls1.2 and Tls1.3.
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Microsoft has recently stopped support for TLS1.0 and TLS1.1. Support for TLS 1.2 was added to Orchid
modules in April 2020 and applies to Sage 300 versions 2018 and above.

Important! If you have any issues emailing, please ensure you download and install the latest product
update for your Sage 300 version.

You get the message “E-mail sent”, but no email is received,

In many cases, there is almost no delay the “E-mail sent” message being displayed on the screen after
clicking “Send Test E-mail”

Ensure the virus checker and firewall on all machines where e-mails are to be sent from. They must
be set to exclude “..\EL6xA\sendmail.exe”
If you get a File missing error, check that the anti-virus is not deeming the sendmail.exe a virus
threat.
SMTP Server may include configuration to expect a valid client certificate from the server-
/workstations where Sage is installed. Once the certificate is installed on the client, emails can be
sent.

You are able to send emails to internal email accounts, but not to external email accounts, the most likely
cause is that your email server requires a valid username /password for sending to external addresses
and the details entered are not correct.

Note: Check your email server to see if it requires a username/password. Some require it to be blank,
for some it does not matter.

Note: Some email servers will allow you to log on as a certain user and send email as anyone, others
will only allow you to send email as the logged on user. So if you log on as "Joe", but try to send as
admin@testdomain, some email servers won't allow it.

Process Scheduler emailing tips

When using Process Scheduler with Extender or Report Runner, the Process Scheduler email settings are
only used if the Schedule is configured to send emails on success or failure.

The Run Information Manager Step uses the SMTP Email configured in Information Manager a> Report
Runner and the Run Extender Script action uses the SMTP email configured in Extender.

When using Process Scheduler to email Reports configured in Report Runner, check the email con-
figuration in Information Manager, not just Process Scheduler.

When using Process Scheduler to run Extender scripts that send emails, check the email configuration in
Extender Options, not just Process Scheduler.
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UPDATES TAB
Use the Options > Updates Tab to see details about product updates available. Also includes a list of
new features and fixes since the initial release.

NOTIFY ME WHEN THERE ARE NEW UPDATES IN ORCHID MODULE
Users can now "subscribe" to notifications of updates.

By Default, this option is not selected for end-user serial numbers

The check is stored in the registry and it applies to this Windows user on this computer.

If selected, when starting Sage it will check if there are product updates available for Orchid Module

If there is a new update, and the user hasn't previously been notified of it, then the Options screen
will open automatically on the Updates tab and display details of the new updates.

Tip: The “administrator” or “super user” or “owner” of Sage 300 should have this option

turned on. All other users should have it turned off.

CHECK FOR UPDATES AND SUPPORT REQUESTS
You can use "Check for Updates" button to view the list of new features and fixes.

To facilitate support, please include the Version and Product Updates you are running when report-
ing any issues.

Updates are available to be downloaded from the partner area of the Orchid website Product down-
loads. 

EXTENDER LICENSE AND WORKFLOW USERS
Use the Licence form to review the Serial Number and Activation Code which has been applied to this
installation.

For details on the Extender License screen, refer to Extender License Screen on page 67.

Note: For details on workflow users functionality and licensing, refer to Understanding Workflow
Users on the facing page

Maintain Workflow Users
Use Extender License Screen to Insert a row for each Sage 300 user that needs to progress the workflow
or view outstanding workflow records.

Tip: Use the INS key on your keyboard to insert a new row
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Note: You can enter users up to the number of workflow users you are licensed for. If you enter addi-
tional users, you will receive a "Too many users" error and your changes are not saved.

IF USING WORKFLOW ANYWHERE MOBILE APP
Select Yes in the "Is Workflow Anywhere" column.

Tip: Use the space bar to toggle between Yes and Blank

Upgrade Steps for Workflow Users
When upgrading from one Sage 300 version to another, make sure the previous version license is in the
Sage 300 Shared Data folder configured for the new version. When you activate Extender to upgrade it,
the users will be imported into the new version automatically.

You can also use the "Import users from prior version" button.

Note: If the new license includes fewer users, the first x users will be imported, up to the number in the
current license.

Example:
If upgrading from Sage 300 version 2024 to Sage 300 version 2023

1. Copy the VI70A.lic file to the Shared Data folder if upgrading to a new server.

2. Activate Extender v2024. This will update the VI71A.lic file with the previously configured users

3. If the VI70A.lic file is not available when activating, you can copy the file after upgrading and use the
Import Users from Prior Version button.

UNDERSTANDING WORKFLOW USERS

Setup Workflow Users
Log in to Sage 300 as ADMIN and use the Extender Setup > Licences screen to view/add/delete users.

For details on using the screen, refer to Extender License and Workflow Users on the previous page

When do you need workflow users
A Workflow User license is required for each user who needs to access Extender Workflow functionality:

Extender Workflow Console: The console lets users monitor workflow instances, drill
down for detail, and progress workflows that have been assigned to them.
Start or progress Extender Workflow using the Icons on Sage 300 screens.
View workflow history using configured icons on Sage 300 screens.
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Access Extender Audit Logs via icons configured on Sage 300 screens to view the
detailed history of logged records.

Requirement! To use the Extender icons on the screens, you need to install and activate
Information Manager. If you are not using other functionality in Information Manager, you don't need
activation details.

Note:
Workflow Users also have access to Email SmartLink: E.g. so a participant in a workflow can be easily
emailed a link to a relevant Sage 300 record.

IF USING REMOTE ACTION SERVICE
A Workflow User license is required for users to progress the workflow through Remote Action Ser-
vice.

This functionality to use a one-time link in a notification email to progress a workflow without need-
ing to be logged in to Sage 300 requires an additional subscription to Remote Action Service.

Note: Workflow Users do not need to use a Sage 300 license if their only interaction with Extender
Workflow will be via the Remote Action Service.

For details, refer to Remote Action Service : Progress Extender Workflow remotely on page 155

IF USING WORKFLOW ANYWHERE
Workflow Anywhere provides an Extender Workflow Console for your mobile device.

To use the Workflow Anywhere App, a user needs a Workflow User license and a Workflow Anywhere
User license. A Sage 300 license is required when the user refreshes the data on the App or pro-
gresses the workflow.

For details, refer to Workflow Anywhere Overview

Workflow template and Workflow Users
When you assign a workflow to a user who is not configured as a Workflow User, the AssignUser work-
flow action returns an error. The next action is configured in the False Action # field in the Workflow Tem-
plate.

Make sure the Workflow Template notifies an Admin user and proceeds with the rest of the workflow
actions.

Tip: You can add a Workflow Action to assign the workflow to ADMIN if the first AssignUser action
returns False
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How do Workflow Users work?

WORKFLOW USERS are NAMED user licenses: 

Each Workflow User license is allocated to a specific, named user.
Named users, up to the number of current Workflow User licences, are assigned in
Extender Setup.
If you are using multiple Sage 300 databases, Named users are shared across all data-
bases where Extender is activated.

Note: A Workflow User license is not required to trigger an automatic Workflow (e.g. by updating a
record in Sage 300)

WORKFLOW COLOURS
This screen allows you to assigne RGB codes to Colour Names which can be used in your workflow.

On the workflow console, a workflow instance will be coloured based on the COLOR value in the work-
flow instance. The "AssignColour" workflow action allows you to assign a colour to a workflow instance
as part of the workflow.

Note: You can filter by up to 5 colors on the workflow console, but you can create as many

colors as required.

STEPS

Enter a Colour Name.
Click in the colour column to select the colour

Tip: Use a name that represents where you will use the colour (e.g. urgent), rather than just Red or
Blue. This makes ongoing maintenance if you want to change the colour of Urgent tasks, you can
change the "Urgent" colour rather than update all the Red colour.

WORKFLOW USER GROUPS
Use this icon to create groups of users who can be assigned tasks in the workflow.

In the console, you can view all tasks that you are assigned to and tasks assigned to a group that you are
a part of.

Note: If you have Security rights to view all Workflow, you will also see workflow instances assigned to
all other users.
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TO CREATE A GROUP:

Enter a name and a Description
Insert rows in the detail grid to select Users.
Users need to be configured in Sage 300 first and should have the security rights in
Sage 300 to perform the tasks required in the workflow.

Example: In a workflow to Approve A/R Credit Limit, create a user group "ARAPPROVER", add Sage
300 users to the group. The users in the Approver group need to have rights to Accounts Receivable,
Customer Maintenance and Edit Credit Limit.

MESSAGE TEMPLATES
Message templates can be used in Extender Events (Send Email and Create Information Manager Note),
Scripts and Workflow Templates.

You select an Email Message ID when you configure Extender Events (for details, View Events, Scripts
& WF on page 106) and on the Workflow Template Action setup (when using a SendEmail action) (for
details, Workflow Templates - Screen Guide on page 90).

Tip: Message templates can be exported and imported to save time re-keying similar messages

Message Templates Field List
MESSAGE ID

A message ID is a unique code of up to 16 characters that identifies a message template.

DESCRIPTION
Enter a description of up to 60 characters for the message template.

EMAIL SUBJECT
Enter a subject line for the email message. If creating a template for I/M Notes, leave the Subject
blank.

EMAIL/NOTE BODY
Enter the body of the message/note template. The body of the message/note template can be as
long as you need it to be. Variables can be inserted in the message template. See below.

COMMENT
Enter a comment up to 250 characters for the message template.
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Message Variables
You can add variables to the subject line and body of your email message and/or to the contents of your
I/M Note. For more information, see Message Template Variables

Attachments
You can include standard attachments to message templates used in Extender scripts and workflow
actions.

To configure: 

Insert a row
Browse to select files to attach to the email.
Repeat for all files you want to attach to the email.

Tip: Use UNC Path and ensure that all users who email can access the folders.

How it works: 

When you load the message template in a script, Extender adds the attachments configured in the
template automatically.
You can also attach files dynamically to the email in a script using email.attach("filename")

Email and attachments

e = Email()

e.load(“template name”) # ← adds any attachments from the email template

e.attach(“filename”) #← also add this file dynamically in the script

Using HTML messages
Email templates are sent as HTML if they contain "<html>" and "</html> Tags.

To add a line, you must use <BR> or include <p>my text</p> around each line.
If copying your existing text email templates, make sure you add <BR> wherever a new line is
required.
To add a logo to the email message, use a hyperlink with an image source file to include a link to a
logo saved on your website or another accessible site.

Insert an image / logo example

<p><a title="Orchid Systems Events" href="https://www.orchid.systems/events"><img

alt="Orchid Website" data-entity-type="file" data-entity-uuid="d728cc57-
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-entity-uuid=5309-4c73-8aa8-5d2bdc7bed25"uuid="d728cc57-5309-4c73-8aa8-
5d2bdc7bed25" /></a></p>

Orchid module doesn't include an HTML Editor, so we suggest you use an online editor (e.g.
https://html-online.com/editor/) then paste the HTML code into the Extender Email editor.

WORKFLOW TEMPLATES
Workflows can be configured to approve new records, approve field changes in Sage 300 or start auto-
matically a series of actions to alert users when something happens in Sage 300.

Note:
Workflow is only available for flat views: Master files (e.g. A/R Customers), Transaction Header views
(e.g. O/E Header) or Batch Header view (e.g. A/P Invoice batch)

Workflow Types
A workflow template is a collection of named steps. Each step can have actions that are performed auto-
matically (e.g. send an email, run a script, wait, goto step). When the workflow requires a user decision to
progress to the next steps, you can use "Progress-to" Steps.

For detailed examples, see Extender Configurator Tutorials on page 9

A workflow can be started automatically

when a view field is updated – you attach the workflow template to a View field.
the insert/update/upsert/delete operation on a Sage 300 view - the workflow template
is attached to a view operation.
by a Python script run on the Sage 300 desktop or attached to a Sage view.
by a Python script run using Process Scheduler.

Approval workflows have two main design options:

1. When a field is updated, the workflow is configured to reset the field to its original value and will only
update it to the requested value when it is approved. See example in A/R Credit Limit Approval on
page 10

2. To approve records being inserted into Sage 300, the workflow needs to be configured to set the
record "on hold" or "Inactive" so that it cannot be used or progressed further until it is approved. see
example in O/E Orders Approvals on page 23

A workflow can be started manually

You can start a workflow manually from an icon on a Sage 300 screen.
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The logged-on user has to be configured as a Workflow User. For details refer to Understanding Work-
flow Users on page 83,

You configure which screens can start workflow in Information Manager Setup > I/M Options.

Refer to Extender Workflow- Notes/DML/Extender Tray .

See example Customer On-Hold Alert and Approval on page 18

Completing a workflow

A workflow is completed when it enters a step which completes the workflow. This is done by including
an action to "Complete the workflow" in the Step actions.

If the workflow is completed, the step name on the workflow console is blank.

If the workflow template has been configured to “Automatically delete when closed” then the Workflow
Instance will be deleted when a closing workflow step has been taken. The workflow History can be used
to view previously completed workflows.

Using the workflow
All workflow (completed and outstanding) are in the workflow history.

Outstanding workflows

A workflow instance is created for each running workflow. It includes fields such as what workflow tem-
plate it is using, the current step, the user who performed the step, the date/time the step was per-
formed, etc. It also has a list of key-values, for example customer, order number, etc.

A workflow instance has a STATUS field and a COLOR field. STATUS can be used by the scripts and is dis-
played in the workflow console. Status is updated through actions configured in the workflow templates.
The COLOR field can be used to colour the rows in the workflow screen (for example, urgent items could
be red).

Setup Workflow templates - Overview
Workflow templates include:

Steps
Progress-to Steps
Actions
Values

WORKFLOW STEPS
A workflow step is a collection of actions taken when the workflow starts or is progressed. Each step
is recorded in the workflow log and can be viewed in the workflow history.

WORKFLOW ACTIONS

Setting Up Extender Workflow Page 89 of 162

../../../../../../Content/Extender/EBTray/Setup-Hotkey-Workflow.htm


Orchid Modules

Actions control what each step of the workflow does. Extender Configurator includes a certain num-
ber of pre-defined actions.

For a list of actions, refer to Configurator Actions on page 136

To add a custom action, you need to be licenced for Extender Customizer or Developer edition and
upload a custom script to the database.

PROGRESS-TO STEPS
Progress-to steps are used when a user needs to select the next Step to progress the workflow. Pro-
gress-to steps add Controls to the workflow console. If workflow screen icons are configured in
Information Manager, Progress-to steps can be run from the configured Sage 300 screen.
For example, a “requires approval” step could progress to an "Approve” or a “Reject” step.

VALUES
Values are variables that can be defined in the Workflow templates and used in the Workflow actions.
Such values are included in the workflow history Log file.

WORKFLOW TEMPLATES - SCREEN GUIDE
Workflow templates include:

Steps
Progress-to Steps
Actions
Values

Tips:
Workflow templates grids are resizable.

You can click on the blue labels - it's the same as pressing F9 to view the details.

Workflow template configuration
WORKFLOW TEMPLATES: FIELDS AND CONTROLS
TEMPLATE ID

Enter a unique workflow template ID. It cannot be changed after the template is created.

If using an Extender Module, make sure the workflow name starts with the module name.

DESCRIPTION

Enter a meaningful description.
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ACTIVE

Select Yes to Activate the workflow.

If you need to select No to deactivate the workflow, make sure you complete existing open work-
flow instances first.

AUTO DELETE INSTANCE WHEN COMPLETE

Defaults to No.

Select Yes to delete the workflow instance when a closing workflow step has been taken. The
instance will only be deleted once the workflow log entry has been created. The workflow history
will remain available.

CAN START MANUALLY

Select Yes to start a workflow from a Sage 300 screen. This requires Orchid
Information Manager activated and configured.

User needs to be an Workflow User to start a workflow manually.

See example setup in Customer On-Hold Alert and Approval on page 18

Select No to start the workflow automatically

The workflow can only be started when a Sage 300 record is inserted or updated (as per View
Events and Scripts configuration).

See example setup in A/R Credit Limit Approval on page 10.

Note: In both cases, you can start a workflow in a custom Extender script, if using Extender Cus-
tomizer or Developer Edition.

CAN START MULTIPLE INSTANCES
This applies to manually started workflow only.

a. “Yes” – then users can start the same workflow for the same key field multiple times.

Tip:
Can start multiple instances: Yes - If you want the workflow to behave differently if there is
an active pending workflow before a new one starts, use the "IfWorkflowExists" action.

b. “No” – do not allow them to start another instance. But no message.

c. “No with message” – do not allow users to start another instance and give them a message
“There is already a workflow instance for workflow template: {workflow template name} and {view
name} - {record key}
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Warning!
When you select "No" or "No with Message", if you update a field/View configured with the
workflow template, and an existing workflow instance is active, the workflow is not
triggered.

This may disable controls you are implementing with this workflow where this workflow has an
active instance is active. USE WITH EXTREME CAUTION. Consider using the "IfWorkflowExists"
action and "Can start multiple workflow" = Yes

Workflow Steps
A workflow step is a collection of actions taken when the workflow starts or is progressed. Each step is
recorded in the workflow log and can be viewed in the workflow history.

The Previous step and next step are visible on the workflow Console.

WORKFLOW STEPS : FIELDS AND CONTROLS
Insert a new line for each Step of the workflow. Provide a Step Name, a description and select
whether the step is an "Entry Step".

Note: You can have more than one entry step in a workflow.

When attaching a workflow template to a View, you can choose the entry step. For

details, View Events, Scripts & WF on page 106

For each step, define Actions.

For steps where a user action is required (e.g. Approval), configure the Progress-to steps.

STEPS AND PARAMETERS
You can configure up to 4 optional parameters when you attach a workflow template to a View in
View Events and Scripts and when configuring the Progress-to Steps.

Parameter 1 is to Parameter 4 is fields on the Steps setup section of the Workflow Template allow
you to describe how the parameters are used in the workflow.

Example: In the A/R Customer Credit Limit approval workflow, Parameter 1 is the maximum
amount a user can update the credit limit without approval, Parameter 2 is the amount above
which a manager's approval is required.

REASSIGN STEP-
Extender includes a default Reassign Step on the console where you can select a user/user group to
reassign the workflow.
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You can design your own Reassign step with custom actions like "send email" - If found, it will be
added to the Console automatically, replacing the default step. You don't need to add it as a Pro-
gress-to Step.

Progress-to Steps
Progress-to steps are used when a user needs to select the next Step to progress the workflow. Progress-
to steps add Controls to the workflow console. If workflow screen icons are configured in
Information Manager, Progress-to steps can be run from the configured Sage 300 screen.

TO ADD PROGRESS-TO STEPS
Select a step and if required, add a row for each step that the workflow can progress to.

You can configure parameters that will be passed to the action when selected.

PROGRESS-TO STEPS AND WORKFLOW CONSOLE
On the workflow console, you will see the available steps depending on the current step that the
workflow instance.

e.g. Approve or Reject.

PROGRESS-TO STEPS AND WORKFLOW SCREEN ICONS
If you have configured workflow on Sage 300 screens in Information Manager, Progress-to steps can
be used from the screen icons.

Add screenshot/link to Infor manager setup

e.g. Approve or Reject.

Workflow Actions
Actions control what each step of the workflow does. Extender Configurator includes a certain number of
pre-defined actions.

For a list of actions, refer to Configurator Actions on page 136

Use F9 to view the details

Click Insert on the grid or the New button on the F9 zoom screen to create a new action.

Tip: Ensure that each Step ends with a Complete action or a GoToStep Action.

ACTIONS : FIELDS AND CONTROLS
Action #

Type an Action number.
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Tip: Leave some gaps in Action numbering to make ongoing maintenance easier. You can
use Renumber before inserting rows. See below.

Action Name

Select an Action.

This will refresh the fields required for each action.

The following actions are pre-configured in Extender Workflow.

An action is a Python script that is stored in the database just like regular user scripts.

Configurator includes a number of predefined actions. For details, refer to Configurator
Actions on page 136

To add a custom action, you need to be licenced for Extender Customizer or Developer edition
and upload a custom script to the database.

Complete Fields required for each action

The field labels on F9 Zoom and the grid headings are named after the parameters configured in the
Extender Script that defines the action.

Actions can have up to 4 parameters, as defined in the Action script.

Comment

Enter up to 250 characters to document how the action is configured.

PARAMETERS AVAILABLE FOR USE IN WORKFLOW ACTIONS.
Use the Help link on the detail action screen for details.

The following values are available to use in action parameters and email templates used in the Work-
flow.SendEmail action:

{$1}, {$2}, {$3}, {$4} - step parameters

{PROGRAM} ID of calling program (eg OE1100 = Order Entry)

{ROTOID} ID of the calling view (eg AR0024 = AR Customers)

{USER} current user (eg ADMIN)

{field} gets a value either from the workflow instance values, or from the target view.

{VIEW.field} gets a value from the target view

{VALUE.name} gets a workflow instance value

{VIEWID} the view ID for this workflow instance

{VIEWKEY} the record key for this workflow instance

{KEYDESC} the description for this workflow instance

{TOVALUE} the requested value for this workflow instance
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{STATUS} the current status for this workflow instance

{COLOR} the colour for this workflow instance

{CURUSER} the user or group currently assigned for this workflow instance

{WTNAME} the workflow template name for this workflow instance

{STUSER} the user who started this workflow instance

{STEPNAME} the current step for this workflow instance

{PSTEPNAME} the previous step for this workflow instance

Formatting Numbers:

Append ':{required decimals}' to the field

E.G. {ORDTOTAL:2}

TRUE ACTION # AND FALSE ACTION #
True Action #: Enter the Action # that the workflow should perform next if the Action returns True

False Action #: Enter the Action # that the workflow should perform next if the Action returns False.

The True and False Action # control what actions will actually take place in the workflow depending
on the result of the Action script.

If you set the True and False Action # to 0, the workflow step will stop with that action.

Important! If an action number is not in a True or False value, they will never be used in the work-
flow.

Example:
Using the Evaluate Action

The Evaluate action is used to compare a field to a pre-defined value (e.g. Credit Limit greater than
a certain amount or Customer Group being a specific value, Vendor name changed from original
value).

If the result of the comparison is false, you can go to Action # 50, Approve automatically. This
action would be configured as GoToStep "Approve".

If the result of the comparison is true, you want the workflow to do 3 actions, Action # 15, Action
#20 and Action #25.

RENUMBER
Use the Renumber to re-order the actions displayed on the screen. Extender will use the action num-
ber, add a gap of 10 so that you can insert new actions and renumber the True/False actions accord-
ingly.

STANDARD ACTION CONFIGURATION AND PARAMETERS REQUIRED.
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Action Name Description Parameters

AssignUser
Assign to a Work-
flow User Group

Select a user group.

To configure a new user group, refer to
Workflow User Groups on page 85.

AssignUser
Assigns a user to
the workflow
instance

You can type a Sage 300 User ID, select
a value defined in the workflow or select
a value set in a parameter when attach-
ing the workflow to a view.

Type {USER} to assign workflow the cur-
rent user.

When you assign a workflow to a user
who is not configured as a Workflow
User, the AssignUser workflow action
returns an error. The next action is con-
figured in the False Action # field in the
Workflow Template.

Make sure the Workflow Template noti-
fies an Admin user and proceeds with
the rest of the workflow actions.

Tip: You can add a Workflow Action to
assign the workflow to ADMIN if the first
AssignUser action returns False

AddParameter

Stores input col-
lected in the work-
flow

Parameters are
added to the Values
of the workflow

Name: can be used in other actions
(such as set field or sendEmail)

Parameters

Label: description user will see when
prompted

Type: 

Parameter types can be:

> text(size=xx)

> integer

> number.0 - eg 10.1

> number.00 - eg 10.12

> number.000 - eg 10.123

> user - a user or user group

> date
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Default Value: Optional -

Parameter values (as entered by the user
) are saved as workflow values and avail-
able on the console.

Parameters can be added to email tem-
plates. Use {PARAMNAME} in the email
template.

AskForParameters

Step will stop at that
step and wait for
user input.

True Action should
be the action you
want to perform
when user has sub-
mitted the input.

No parameter.

Execution continues at the AskForPara-
meters True Action step #.

If the user selects "Cancel" on the UI, the
action returns False.

Tip: Configure the actions in the tem-
plate if you want different process flow
if a user enters input or clicks Cancel.

This action is not active when the work-
flow is progressed through a script, for
example the Remote Action poller.

AssignColour

Assigns a color to
a workflow
instance in the
Wokflow Console

Select a color using the Finder.

To configure colors, refer to Workflow
Colours on page 85

Complete

Action to ensure
that the action com-
pletes the workflow.

If Auto delete
instance when com-
plete is set to Yes on
the workflow, the
instance will be
deleted when the
Complete step is
successful

No Parameter.

When the workflow is complete, no fur-
ther processing happens.

The next step in the Console shows as
Blank

CreatePOfromReq
Create a PO from
a requisition

Requisition requires a vendor on
the Header. All lines must use the
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same vendor. No parameters

Evaluate
Used to set con-
ditional workflow

Field, Operator, Value

If evaluating a Boolean field, use 1 for
True/Yes or 0 for False/No

Notes:
If the Field is set to {PROGRAM}, the
action will compare the RotoID of the
screen running the workflow to the
value defined in the Value parameter.

If you only want the workflow to do cer-
tain actions for certain users, you can
use Evaluate {USER} to use the logged
on user in the condition.

Gen-
erateAPPay-
mBatchListing

Runs and saves as
a PDF the
AP Payment Batch
listing report

For use in a workflow template to
approve AP Payment batches

See example in A/P Payment Batch
Approval on page 42

GetOptField

Used to read
Optional Field
Value to use in
workflow

Parameter 1 = Optional Field View ID -
Use View Info to select - Use PO0623 for
PO Header Optional Fields or G/L0400
for GL Account Optional Field

Parameter 2 = Optional Field Name

Parameter 3 = Workflow Value

GoToStep Go to another work-
flow step. Select Step name

IfWorkflowExists
Returns True if
there is a pending
workflow.

Can be used in the workflow template to
have different actions if the workflow is
Active.

Can also be used in View Events
and Scripts to make a field ReadOnly if
using Extender Customizer or Developer
Edition.

IfWorkflowUI

Returns True if
the workflow is
progressed on
the Console or

Used in the workflow template to have
different branches if the step is used on
the console and in a script such as the
Remote Action Poller.

Users are generally not prompted for
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the workflow
screen icons.

parameters or displayed messages when
the workflow is progressed in a script.

IsDelete

Returns True if
the workflow is
part of a
DELETE view oper-
ation.

This only applies to Master file and
Transaction views.

When a batch is "Deleted", the status is
set to "Deleted", the Delete view oper-
ation is not run.

Tip: Use the Batch status field on the
Batch if you need to trigger a workflow
when a batch is deleted.

IsInsert

Returns True if
the workflow is
part of an
INSERT View oper-
ation

Can be used when a workflow is
attached to an UPSERT View operation
or a View Field.

This only applies to Master file and
Transaction views.

When a batch is "Inserted", the batch is
created immediately without running an
"INSERT" View operation.

Tip: Use the Number of Entries field on
the Batch if you need to trigger a work-
flow when a batch is inserted (Number
of entries = 0)

IsUpdate

Returns True if
the workflow is
part of an
UPDATE View
operation (vs an
INSERT)

Can be used when a workflow is
attached to an UPSERT View operation
or a View Field.

You may have different actions when a
new ON HOLD order is inserted vs when
an existing order is updated to "On
hold"

IsUserMemberGroup

Return True if the
user configured in
Parameter 1 is
part of the Work-
flow User Group
in parameter 2

To use it for the logged on user,
you can use {USER} in Parameter 1

Reassign Reasssign a user to If there is no reassign step then the user

Setting Up Extender Workflow Page 99 of 162



Orchid Modules

another user/group

Displayed in the
workflow console.

is prompted for the user/group to reas-
sign to, then the workflow user is set to
that user. If you have a step called "reas-
sign" in your workflow, the custom step
is run.

Example: If you want to send an email
when a workflow is reassigned, add your
own Reassign Step.

PostBkEntry PostBkEntry

The PostBkEntry posts the bank entry
configured in the Workflow Instance ID.
Use in a workflow template associated
with the Bank Entry View.

Approver needs rights to post Bank
Entry in Sage Security

PostBatch

PostAPAd-
justmentBatch

PostAPInvoiceBatch

PostAPPay-
mentBatch

PostARAd-
justmentBatch

PostARInvoiceBatch

PostARReceiptBatch

PostARRefundBatch

PostGLBatch

ProvPostGLBatch

The Post_Batch actions post the relevant
batch. Batch number entered as Para-
meter 1.

The approver needs rights to Post the
batch in Sage security.

SendEmail

Sends an email to
the user / user
group or email
address con-
figured in Para-
meter 2.

Parameter 1 = Email template - You can
use the finder to select the message tem-
plate.

Parameter 2 = Email address or Sage
300 User or Workflow user group.

You can use {CURUSER} to send a noti-
fication to the user assigned to the work-
flow. Make sure the SendEmail Action is
after the AssignUser Action.

User
pro-
file
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Note:

In Parameter 2, enter a list of

email addresses separated by

a ;

You can add email addresses

(someone@company.com, a

Sage User ID or an Extender

workflow user

If selecting a Sage 300 user

(eg ADMIN), an email is sent

to the email address con-

figured in Sage 300 User pro-

file.

If selecting a Workflow user

group (eg APPROVERS), all

users in the group are sent an

email, to the email address

configured in Sage

You can combine email

addresses (e.g. someone@-

company.com) and user

groups

Example: someone@-
company.com;ADMIN;APPROVERS;
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Optional: CC, Subject (to overwrite email
template subject)

SendEmailAttachments
Sends an email
with an attach-
ment

Extender Message template - Can
include variables from the view the work-
flow is attached to

Email address configured in Parameter
2: refer to SendEmail action above.

Set the path and filename of the attach-
ment in a Workflow value and enter the
workflow value name in P4.

Ensure the path is set to UNC format
and the users have access to it.

SendEmailToStarter
Sends an email to
the user who star-
ted the workflow

Email template, CC, Subject

SetDescription

Sets the workflow
description for
use in Console
and workflow
logs.

You can use any string/word as well
as workflow and view variables.

SetDrilldown

SetDrilldown sets
a value to a Sage
300 view field to
enable Drilldown
from the console
to the underlying
Sage 300 screen.

Parameter 1 is the field name that is
used as the KEY field in the vid-
rilldown.ini file.

Parameter 2 is the value you want to set.

For example {IDCUST} for the customer
number from an ARCUS workflow.

For details, refer to Drilldown in work-
flow on page 146.

SetField

Sets a configured
field to a value.

Field can be any
field on the view
that the Workflow
will be attached to

Use Extender Extender View
Info to identify the Field name
e.g. AMTCRLIMIT for an
A/R Customer workflow
Add the field name between
curly brackets {}.
Use values defined in the
workflow or a set value (e.g. 1
to set OnHold to true/se-
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lected)

You can use {VIEWID}, {VIEWKEY},
{KEYDESC}, {TOVALUE} - these cor-
respond to the View ID, Record Key,
Description, and Requested Value
columns in the Workflow Console
screen.

Example: To prevent a change to the
credit limit, you use SetField to restore
the value to the previous value using
SetField and {ORIGINAL_AMTCRDLMT}

Note: You can update 2 fields with
SetField . This is useful when updating
SalesPerson and SalesPercentage on
OE Order.

SetOptField
Set an optional
field value

Parameter 1 = Optional Field View ID -
Use View Info to select - Use PO0623 for
PO Header Optional Fields or G/L0400
for GL Account Optional Field

Parameter 2 = Optional Field Name

Parameter 3 = Optional Field Value

SetStatus

SetStatus will set
the status of a
workflow
instance. The
Status is shown
on the workflow
Console

P1 is the status you want to set to
the workfow instance. Displayed on
the console, on the worklfow logs
and in the workflow reports.

SetValue

SetValue will add
a row to the work-
flow instance val-
ues grid.

Parameter 1 is the field name that you
want to give to the Value.

Parameter 2 is the value you want to
pass. It can be hard-coded, set to a
value defined in the workflow or set to
the View Field original or new value.

Use the field name between curly
bracket to store the new amount (e.g.
{AMTCRDLMT}
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P1 can be set to {VIEWID} and value
would be the Sage 300 View ID when a
workflow is started from a screen and
not attached to a view.

ShowUserError
Displays a Error to
the logged on user
on the Sage screen.

As above.

ShowUserMessage

Displays a Message
to the logged on
user on the Sage
screen.

Parameter 1: Text to display.

For information The message can
include Variables, such as Workflow
fields or Values from the workflow.

Use an Evaluate action before using the
ShowUser actions to ensure that the
message is only showing when the view
is used on a Sage 300 screen.

field: "{PROGRAM}"

operator: "="

value: "AR1300" (RotoID of the screen
that should display a message).

ShowUserWarning

Displays a Warning
to the logged on
user on the Sage
screen.

As above.

Workflow Values
Values are variables that can be defined in the Workflow templates and used in the Workflow actions.
Such values are included in the workflow history Log file.

USING VALUES
if you use the SetValue Action, the workflow log will track the value for each step of the workflow
instance.

Values can be hard-coded in the workflow, set to View fields when the workflow is attached to a view
(e.g. {ORIGINAL_FIELDNAME} , or set in the workflow based on parameters configured on View
Events and Scripts.

You can also Values from workflow instance

{VIEWID}, {VIEWKEY}, {KEYDESC}, {TOVALUE}, {STATUS}, {COLOR}, {CURUSER}.
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Tips:

You can export and import workflow templates. Choose File Menu from the Workflow

Templates Screen. "Export" exports the currently selected template, "Export All"

exports all Workflow templates. Use Import and select the file with your workflow

template/s.

When importing workflow templates, you can only INSERT new templates, where the

Template ID doesn't exist in the database. The column WTID needs to be in the

Import file with any Integer value to link the workflow steps, actions, progress to

steps and values. It will be auto-assigned during the import to the next available

value.

You can also export Message Templates, User Groups and Colours.

LINK WORKFLOW TEMPLATE TO EXTENDER VIEW OR
SCREEN

To start a workflow automatically: 
You can attach a Workflow Template to a Sage 300 View operation and/or View field/fields. The work-
flow will start automatically when the view is used in Sage 300.

For details on how to add a workflow to a Sage 300 View, refer to View Events, Scripts & WF on the next
page

when a view field is updated – you attach the workflow template to a View field.
the insert/update/upsert/delete operation on a Sage 300 view - the workflow template
is attached to a view operation.
by a Python script run on the Sage 300 desktop or attached to a Sage view.
by a Python script run using Process Scheduler.

To start a workflow manually:
You can start a workflow manually from an icon on a Sage 300 screen.
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The logged-on user has to be configured as a Workflow User. For details refer to Understanding Work-
flow Users on page 83,

You configure which screens can start workflow in Information Manager Setup > I/M Options.

Refer to Extender Workflow- Notes/DML/Extender Tray .

View Events, Scripts & WF
Use this form to add Extender events, custom scripts and workflows to Extender views and fields.

Select a Sage 300 View to be configured with Extender.

By clicking on the “All Views” info icon (or use F6 key) , you can select the appropriate view from the list
of available views, active in your Sage 300 database.

Fields and Controls

REMEMBER ORIGINAL VALUES FOR: 
You can determine what fields Extender need to track the original value for. This is particular useful
for email messages.

Leave blank if you don't need the original value in the Script, workflow or email messages.
You can enter the field names you need. For example, if you only need the original value for
the Description and the name, “DESC,NAMECUST”
Use * if you want Extender to make the original value available for all fields. This is useful if you
use the original values in a script, in email messages or in a workflow, but you don't want to list
all the fields you need in advance.
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Note: On some views that have many columns and that are opened many

times, e.g. the OE Shipment Header and OE Shipment detail view, using *

may have an impact on performance.

Tip:
You can also add code in the script to determine what fields the script needs the original value.

Refer to Scripts-AdvancedTips*

Events Tab

On the Events tab, you can attach an Event Type to an Extender View operation and/or View field/fields.

Requirement! The Events Tab is available if using Extender Levels Configurator, Customizer or
Developer

FIELD NAME

Select the appropriate view field from the list of available view fields. All view fields will be available,
including the following standard operations of a Extender view

Delete : when a view record is deleted
Insert : when a view record is inserted
Update : when a view record is updated
Update and Insert <UPSERT>: when a view record is updated or inserted

ACTIVE

Set to No if you want to Deactivate an Event temporarily without deleting it.

EVENT CODE

Select the appropriate Event Code from the list of available Event Types.
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Important!
If you need to log the Before and After Value, you need to make sure the event type you select has
been configured as "Don't Combine".

If you select the View Operation {INSERT}, {UPDATE} or {UPSERT}, the Before and After values will be
available if the event is configured as "Don't Combine". One record will be added to the LOG or
emailed for each field that is changed.

For the "Delete" action, only one record will be logged.

Refer to Event Types.

Scripts Tab

On the Scripts tab, you select the Python script to be run when the selected view is being updated. Mul-
tiple scripts can be selected, and are run in the order specified.

Requirement! The Scripts Tab is only available if using Extender Levels Customizer or Developer

ACTIVE

You can activate or deactivate a specific script without deleting it from the View

RUN ORDER

If multiple scripts have been defined, you can select the order in which they run by entering a num-
ber associated with each script. A script associated with Run Order 1 will run before a script asso-
ciated with Run Order 2 etc.

FILE NAME (F9 TO EDIT)

If you are uploading a new script, click F6 to browse and find the .PY file to attach to this view.
When selected the script will be

Copied to the associated COMPANY directory, and this is where the “.PY” file will be invoked
from
Imported into the database

If you are attaching a script which already exists in the database, click F9 to find the existing script,
and associate with the current view.

If you want to edit an existing script, click F9

STATUS

Shows blank or “Checked Out” if currently checked out. In order to check out a script for amend-
ment, you can right hand mouse button on the script row, and select Check Out. Once checked out
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you can open (to edit the script), and upload (to replace the existing script with the amended
script).

CHECKED OUT BY

User id who currently has the script checked out

Tip: Once you have uploaded a Script and it is active against a view, you can “check out” the
script to make changes to the script, to test the script while leaving the original script active. Once
you “check in” the script, the existing script will be replaced with the new script.

PARAMETER 1..PARAMETER 4

Your scripts can contain up to 4 parameters.

You can access the parameters in the Python script with the global variables Parameter1, Para-
meter2, Parameter3, Parameter4.

Note: The first few rows of the highlighted script will be shown to assist with the commenting and
verification of the attached scripts.

Tip: To check out, open, upload or Undo Checkout, right hand mouse button on the required script
and select the required action.

Important!
If you need to amend a script after it is attached to a view, you need to check it out, open it to make
the changes, save the script and check it in to enable the changes.

If the script is amended on a separate machine, you need to re-import the PYTHON script

When PYTHON scripts are attached to a view they are

1. Imported into the associated database, so the script will dump and load with the

database

2. Copied to the Company directory, where the PYTHON script is run - If you edit the

script directly in this directory, your changes might get overwritten.

OCX Scripts do not need to be added to a Sage 300 View. The script name matches the Sage 300
screen Roto ID to indicate that the script is enabled.

Workflow Tab
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On the Workflows tab, you can attach a Workflow Template to a Extender View operation and/or View
field/fields. The workflow will start automatically when the view is used in Sage 300.

You can use F9 to open the Workflow Template screen from the Screen.

FIELDS AND CONTROLS

Requirement! The WorkflowTab is available if using Extender Levels Configurator, Customizer
or Developer. If using Configurator, you can only use pre-configured actions in the workflow tem-
plate.

FIELD NAME

Select the appropriate view field from the list of available view fields. All view fields will be avail-
able, including the following standard operations of a Extender view

This allows you to attach a Workflow Template to

• Any field. If a field has an Active Workflow Template, the new value entered will be stored in
“{NEWVALUE}” and the original value reset before the record is saved. This new value will be
available in the workflow

• Insert/Update/Delete. The record will be saved and then the workflow will be started.

Delete : when a view record is deleted
Insert : when a view record is inserted
Update : when a view record is updated
Update and Insert <UPSERT>: when a view record is updated or inserted

ACTIVE

Set to No if you want to Deactivate an Event temporarily without deleting it.

WORKFLOW

Select the appropriate Workflow from the list of available workflow templates. Workflow Tem-
plates - Screen Guide on page 90

ENTRY STEP

Select the step that will be run when the field changes / view operation completes.

PARAMETER 1 TO 4

You can pass up to 4 parameters to the workflow.

To use the parameter value in the workflow, use the SetValue action. You can use {$1}, {$2}, {$3},
{$4} to set the value to a field.

For details and examples, Using Parameters in Workflow on page 145
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Important!
Workflow is only available for flat views: Master files (e.g. A/R Customers), Transaction Header views
(e.g. O/E Header) or Batch Header view (e.g. A/P Invoice batch)

Tip: View Events and Scripts can be exported and imported using the File Menu.

If you select Export, then only the current View configuration will be exported. The

export includes the attached events and scripts.

If you select Export All, then all the current View configurations will be exported. The

export includes the attached events and scripts for all configured views. The export

format is proprietary, and cannot be changed.

Note: Different options are available depending on the level of Extender you are running.

Extender Workflow- Notes/DML/Extender Tray
You configure an Extender Workflow row to add Workflow icons to a Sage 300 screen.

The icons allow Workflow User to start a workflow if it can be manually started, progress a workflow to
the next step if you are an approver, and view the workflow status and workflow history.

WORKFLOW ICONS EXPLAINED
Workflow icons only show if a workflow is configured on a specific field.

One or no workflow icon can be present per screen. Subject to Sage 300 security rights, you can use
the icons to view the workflow history.

Depending on the workflow configuration, you can also use the icons to start or progress the work-
flow.

Click to start manual workflow or view workflow history. There is no pending workflow.

Click to view active workflow. The pending workflow is not assigned to the logged on user.

Click to progress your active workflow. The workflow is assigned to the logged in user and wait-
ing for an action.
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Click to progress group active workflow. The workflow is assigned to a workflow user group
that the logged in user is part of. The workflow is waiting for an action from one of the group mem-
ber.

Note: If the workflow icons are not configured in Information Manager Options, users can run the
workflow Log reports to view workflow history. Workflow users can use the workflow console to
view and progress their active workflows.

Configure Tray

Select Extender Workflow Note Type -Alert Based on Extender Script (For further details on note type,
view below)

Fields and Controls

ROTOID - UNIQUE ID FOR EACH SCREEN
Enter the RotoID of the screen that should display the Extender Workflow Icons.

Example: Enter RotoID AR1300 to display a A/R Customer workflow on the A/R Customer screen.

Tip: To know what RotoID/Field label to use, start the appropriate Sage 300 Screen (for example
AR Customers) then Right hand mouse click on the Information Manager Tray Icon (the key). Now,
as you click on fields in the Sage 300 Screen - the Infoset Hotkey Setup shows you the RotoID and
Field Name.
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FIELD LABEL
Enter the field label from the Sage 300 screen which is to trigger the display of the Extender Work-
flow icons.

If the Field Label is entered with quotes, e.g. "PY", Information Manager will use the hard coded value
in addition to the value set in the Second Field Label.

Important!
1. The same field may have different labels on different screens. See Example 1 below

2. The same field label may be used on the Header and Grid component of the same screen. See
Example 2 below. Adding "F."to the field label forces it to use the field control and "G." forces it to
use the grid control.

Examples:
1. In AR Receipt Entry there are two Document Number fields - one on the header and one in the
grid. To force the tray to use the correct one, you should use "F.DOCUMENT NUMBER" for the
screen label or "G.DOCUMENT NUMBER" for the grid field label. .

2. If you want the same list of documents to show on both the AR Customer Screen and the AR Cus-
tomer Inquiry, you need to add two rows in the IM Setup\Options on the Notes/DML/Extender
Tray tab. One for the Field Label “CUSTOMER NUMBER” and one for the Field Label “CUSTOMER
NO.”

SECOND FIELD LABEL
Enter the second field label from the Sage 300 screen which is to trigger the display of the Extender
Workflow icons. If entered, then the document list will displayed for Field 1 = Field label and Field 2 =
Second Field Label.
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Second Field Label is optional and is configured in the same manner as the Field Label.

EXTENDER WORKFLOW
Browse to select the Extender Workflow template to be added to the Sage 300 screen.

The workflow needs to be attached to a Sage 300 view that is related to the screen the icon is
attached to.

WORKFLOW ENTRY STEP
If the workflow template "Can be started manually" is set to "Yes", select an Entry Step. This will
enable users to start the workflow manually from the screen.

If the workflow template "Can be started manually" is set to "No", don't select an entry step. Th work-
flow will be started automatically if configured in View Events and Scripts and you can view the Work-
flow Log and progress the workflow from the screen.

Examples

Example:
A/R Customer workflow on A/R Screens

If you have an A/R Credit Limit approval workflow, you can add the icons to selected screens: 

A/R Customer Screen- RotoID = AR1300 and Field Label = Customer Number

A/R Customer Inquiry screen - RotoID = 1700, and field label = Customer No
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Example:
A/P Payment Batch workflow on A/P Payment batch screen

The A/P Payment batch view has a multi-part key, including the Batch Type and the Batch Number. The
workflow key is set to PY,Batch number, so the Information Manager configuration needs to include 2
fields as shown below.

Field 1 should be set to "PY" (with quotes) and field 2 set to BATCH NUMBER.

Requirement!
Selecting this option requires Orchid Extender and Information Manager to be installed and activated.

To use the functionality, a user needs to be flagged as a Workflow User. For details on functionality
and licensing method, refer to Understanding Workflow Users on page 83

Note:
If the Information Manager Tray is not started, the icons will not show and the user will not be able to
use the workflow icons to start or progress the workflow.

However, workflows attached to view operation or view field changes will be started and users con-
figured as Understanding Workflow Users on page 83 are able to access the Workflow Console.

You can start the tray manually in Information Manager > Tray Icon.
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Configure Orchid User

How do Orchid Users work?

DML USERS ARE CONCURRENT ("FIRST COME, FIRST SERVED") LICENCES:

Each Sage 300 user who requires access to Document Management Link needs to be flagged as a DML
User.This is done by selecting Options on the Information Manager tray icon, then ticking the DML User
checkbox.

To enable the functionality, that user also needs to be allocated an available DML User license.

There is no limit to how many Sage 300 users can be flagged as DML Users, but only the number of
licences purchased will be available for concurrent use.

DML User licences are issued on a concurrent basis. DML User licences are allocated on a 'first come, first
served' basis, as users sign in to Sage 300, and are released when those users sign out.

Once the available licences have all been allocated, other users will see a 'No Available DML User' mes-
sage.

When a DML User signs out of Sage 300 their license is released and becomes available for another user.

WORKFLOW USERS are NAMED user licenses: 

Each Workflow User license is allocated to a specific, named user.
Named users, up to the number of current Workflow User licences, are assigned from
within Extender.
Workflow Users do not need to use a Sage 300 license if their only interaction with
Extender Workflow will be via the Remote Action service.

Setup DML User

To enable functionality in Document Management Link , the logged on user needs to be set as a
"DML User".

1. In the System Tray, select the Orchid I/M Tray icon and drag it onto the taskbar. This makes ongo-
ing support easier.

2. Click on the Tray Icon, select Options.
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3. Tick "DML User" checkbox (or un-select if a user no longer requires the functionality)

Tip: ADMIN is automatically selected as an DML User.

4. If using SharePoint, enter the user's logon details.
a. Leave the details blank if using Multi-Factor Authentication and basic authentication is dis-

abled. Users will be prompted to enter their details and follow the MFA prompts when they
use the Tray.

b. If enabled in your site, you can also create an App Password for each user.

Refer to Using Orchid Modules with Office365 and Multi-Factor Authentication for details.

5. Save the tray
6. Restart the Sage desktop
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Setup Workflow User

To enable functionality in the Workflow Console, workflow icons and Extender Log icons, the logged on
user needs to be set as a Workflow User.

Refer to Extender License and Workflow Users on page 82

Tip: ADMIN is automatically configured as a Workflow User.

Setup Workflow Anywhere User

To use Workflow Anywhere Console mobile app, the logged on user needs to be set as a Workflow Any-
where User.

Refer to Extender License and Workflow Users on page 82

Tip: ADMIN is automatically configured as a Workflow Anywhere User.

REMOTE ACTION SERVICE : PROGRESS EXTENDER
WORKFLOW REMOTELY
When a Workflow Action is assigned to an individual (or group member), they can be notified by email.
That email is configured to contain a unique hyperlink to a Remote Action service web page/fleeting
form.

The Remote Action page is entirely independent from Sage 300, and merely requires internet access. The
form is unique to a given user and Workflow Action.

The form is configurable in the Workflow Template. E.g. it could include Approve and Reject buttons, cap-
ture a comment, and capture new values for a Sage 300 field related to the action.

Completed forms are pulled into Sage 300 when required. Orchid Process Scheduler can be used to poll
the Remote Action site automatically on a regular basis for newly completed action data, and feed the
results back into Sage 300 to progress the Workflow. Completed forms are then deleted from the web-
site.

To get started, refer to Remote Action Service - Getting Started on page 156

Refer to Online Help for details. Remote Action Service Online Documentation

Remote Action user guide can be found online: User Guides
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REMOTE ACTION SERVICE - GETTING STARTED
Remote Action service is used in conjunction with Extender workflow to enable approvals of Sage 300
records outside of the Sage 300 environment. Approvers receive a one time email link that they can use
to complete the Approval (or rejection) form.

For details on how it works - refer to Remote Action Service : Progress Extender Workflow remotely on
page 155

In most cases, you configure the Extender Workflow as per your required flowchart first without Remote
Action Service. Once you have tested the workflow template, you can add a Remote Action Service
action to send the email to the approvers with the link to approve outside of Sage 300.

Example: Tutorial: Remote Action tutorial - A/R Credit Limit approvals
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Requirement!
The following modules are required to use the Remote Action Service: 

Extender (Configurator or Developer)
Workflow Users
Remote Action Subscription
Process Scheduler Level 1 and above to automate completed form retrieval (optional
but highly recommended)

Prerequisites - install Extender and Remote action service

Extender setup

Ensure the latest product update for Extender installed and activated.
In Extender Options, set the Python version to version 3.8.8 - Refer to Python Version
on page 74
In Extender Options > Email Tab, configure the SMTP Details as Remote Action service
needs to email. Refer toExtender Email Tab on page 75
Configure Workflow Users. Extender License and Workflow Users on page 82

Install Remote Action Service

Subscribe to the Remote Action Service through your Sage 300 Business partner and
have the token available.
Import the RemoteAction.vi module

REMOTE ACTION MODULE DETAILS
The Remote Action module includes the Extender custom tables and scripts required to configure
and manage the service.

Remote Action Scripts
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Workflow Actions

It also includes three workflow actions to build the form hyperlink and email the on-time link to the
workflow users.

SendRemoteActionCommentAmountFormEmail includes a comment and an amount field for the
approver to complete. Amount defaults to the requested value in the workflow.

Example: Used to Approve A/R Credit limit

SendRemoteActionCommentFormEmail: includes a comment field only.

SendRemoteActionFormEmail: No user input is captured. Form only includes the buttons configured
in the workflow template.

Custom Table and Configuration record

Remote Action includes a default handler in the Remote Action Handlers custom table for use with
the workflow. This is created when you install Remote Action module. In some rare cases, if the con-
figuration record is missing, you may need to add it manually.

Form Type: workflow_approval

Handler Class: remote_actions.handlers.workflow_approval.WorkflowApprovalFormHandler

Install Process Scheduler

Although this is optional, it is highly recommended to automate the retrieval of the completed remote
action forms. Refer to Running the Poller with Process Scheduler on page 123
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Configure Remote Action module
Step 1: Go to Remote Action menu, select Configure and enter the token provided.

Note: If you don't have a token, contact your Sage 300 Business Partner to enable the service.

Step 2: Run Remote Action Option - Optionally, enter a website address for the logo you want to see
on the form and an email address to be displayed on the form. For details, refer to Remote Action
Admin.

Step 3: Add Extender Message templates to configure the notification email and the remote form con-
tent. For details, Remote-Message-Templates

Step 4: Include one of the Remote Action in a workflow template - For details, Add Remote Action
Workflow Template

Configure Remote Action poller
To process the remote requests into Sage 300, you can run the Extender RemoteAction.poller script. The
script is in the Extender > Remote Action menu

Note: The script can only be run manually by the ADMIN user.
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POLLER DESCRIPTION

Poller is an Extender script designed to process all completed requests and bring the action results
into Sage 300 to progress the workflow.

The RemoteAction.poller connects to the Remote Action Service to retrieve and process completed
forms. For each form, it progresses the workfow according to the details submitted by the user on
the Remote Action form.

For example, if the user approves the workflow request, the workflow status is updated as per the
Approve step configured in the workflow template.

If the poller encounters any error, for example another user has already approved the workflow,
using their Remote Action link or using the Extender console, the poller will log an error.

Running the Poller with Process Scheduler

In most cases, you configure Process Scheduler to run the script and use Windows Task Scheduler to
update the data automatically as often as required.

Setting Up Process Scheduler - Configure Process Scheduler to run the imports automatically

Setting Up the Windows Scheduled Task - Task Scheduler

Tips:
The user configured in Process Scheduler Companies needs to have "Modify all workflow" rights in
Sage Security Groups as it needs to progress the workflow records. It also needs to have all the Sage
security rights to perform the actions in the Approve/Reject steps (e.g. Post batches, update Customer
or Vendor).

It is important that an admin user reviews the Process Scheduler Logs regularly.
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Using Extender Workflow
Once Extender is configured, you use it by interacting with the Sage 300 screens and views.

Many workflows are started automatically when a view field is updated or a record is inserted.

To start a workflow manually: 125
Progress Workflow on the Workflow Console 125
Using Icons on Sage 300 screens 126
Progressing Workflow Outside of Sage 300 126
Workflow History 126
Using Workflow Console 127
Workflow Detail Log 130
Workflow Summary Log 131
Print Workflow History Log Report 133
Using Extender Tray Icons 134

TO START A WORKFLOW MANUALLY: 
Set "Can start manually?" = Yes on Workflow template
Add an Extender Workflow record in I/M Setup > Notes/DML/Extender Tray for the
screen where you need to add an icon to start the workflow
Open the Sage screen as a user marked as " Workflow User" , click on the Workflow
icon on the screen .
Select "Start ... (workflow name)"

Requirement!
To use the functionality, a user needs to be flagged as a Workflow User. Understanding Workflow
Users on page 83

PROGRESS WORKFLOW ON THE WORKFLOW CONSOLE
To navigate through the workflow records, approve or reject requests and drill down to Sage 300
screens, you can use the Workflow Console.

For details on the Console, Using Workflow Console on page 127.

Requirement!
To use the functionality, a user needs to be flagged as a Workflow User. Understanding Workflow
Users on page 83
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USING ICONS ON SAGE 300 SCREENS
You can also use tray Icons configured on the Sage 300 screens in Information Manager I/M Options.

For details, Extender Workflow- Notes/DML/Extender Tray (IM Options)

Requirement!
Information Manager needs to be installed and activated.

To use the functionality, a user needs to be flagged as a Workflow User. Understanding Workflow
Users on page 83

PROGRESSING WORKFLOW OUTSIDE OF SAGE 300

Using Remote Action Service
This enables Workflow Users to use a one-time link in a notification email to progress a workflow without
needing to be logged in to Sage 300.

For details, refer to Remote Action Service : Progress Extender Workflow remotely on page 155

Requirement!
Requires an additional subscription to Remote Action Service

To use the functionality, a user needs to be flagged as a Workflow User. Understanding Workflow
Users on page 83

Note: Workflow Users do not need to use a Sage 300 license if their only interaction with Extender
Workflow will be via the Remote Action Service.

Using Workflow Anywhere
Workflow Anywhere provides an Extender Workflow Console for your mobile device.

Requirement! To use the Workflow Anywhere App, a user needs a Workflow User license and a Work-
flow Anywhere User license. A Sage 300 license is required when the user refreshes the data on the
App or progresses the workflow.

For details, refer to Workflow Anywhere Overview

WORKFLOW HISTORY
Workflow logs are available to users based on security setup.

Refer to Workflow Detail Log on page 130
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USING WORKFLOW CONSOLE
Requirement! You need to be a Workflow User to open this screen. Refer to Understanding Workflow
Users on page 83

The Workflow Console displays workflow instances. A workflow instance is created when a workflow is
started. It is updated when workflow steps are run.

It includes fields relating to the workflow template it is using, the current step, the requested value for
workflow requiring a specific field approval, etc. It also has a list of key-values, for example customer,
order number, etc.

The Console lets you progress the workflow to the next steps if you have the appropriate security rights.

Console and Security Groups
The Console screen lets you see all active workflows if you have the “View All Workflow Instances” secur-
ity group , or just those assigned you or to a group which you are a part of.

Refer to Adding Security on page 71.

Note: Unassigned shows workflows assigned to a Sage user or user group that is not configured in
Workflow Users in Extender Licence

Tip: If you use a Workflow button when you are not assigned to the workflow and don't have "Modify
All workflow instances" security group, you will get a security error message and the workflow will not
progress.

how to use console grid
FILTERING THE CONSOLE

You can filter by up to 5 colors on the console. To configure colors on the console, refer to Workflow
Colours on page 85

You can also use CTRL F to filter on any fields.

Select the Template column on a row on the console, use CTRL-F and select Template = "AR Credit
Limit workflow". This will display only Workflow records for the AR Credit Limit workflow.

You can use CTRL -F > Clear filter to remove all filters and view all records.

FIELDS ON CONSOLE
Template ID: Set when the instance is started

Tip: Double click on the Template name to open the workflow template screen if you have security
rights to Edit Workflow setup. For details, Workflow Templates - Screen Guide on page 90

Started On: Date when instance started
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Started At: Time when instance started

Started By: User who started the workflow (manually or through a View operation)

Assigned To: User or user group currently assigned to the workflow.

View ID: Populated automatically by the workflow if it is attached to a View in View Events and
Scripts, or populated using SetValue in the workflow template.

Record Key: populated by Key field for the record subject to the workflow (can be a Customer num-
ber, an Order Number, a Batch Type and Batch number combination

Description*: Configured in the workflow template.

Requested Value: This is populated automatically when the workflow is attached to a specific field in
View Events and Scripts.

You can use SetValue action, Value field = {TOVALUE}, value = {VIEWFIELD} such as ORDTOTAL when
the workflow is attached to a View operation such as UPDATEor INSERT

Step: Shows the current step the workflow is on. If there are Progress-to steps defined for this step,
you will see a custom button for each step defined as Progress-to.

Status*: Configured in the workflow template.

USE CTRL F TO FILTER ON ANY FIELDS.
Select the Template column on a row on the console, use CTRL-F and select Template = "AR Credit
Limit workflow". This will display only Workflow records for the AR Credit Limit workflow.

You can use CTRL -F > Clear filter to remove all filters and view all records.

how to use console buttons
You can progress a workflow to another step. So the buttons you can see on the console depend on
what row /Workflow instance you are looking at and how the workflow is configured.

All workflows will have some default buttons:

DRILL DOWN
When configured in the workflow template, each workflow instance allows drilling down to a Sage
300 screen– for example, you could drill down to the customer, or to the order.

A workflow instance has a list of values associated with it – for example, a customer number or an
order number. Drill down works on this list of values. Refer to details in Drilldown in workflow on
page 146

Example:
If the workflow has a value called IDCUST then drill down to the AR Customer screen will be
enabled for the workflow.

HISTORY
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Use the History button to view details of previous actions on the workflow record selected on the con-
sole.

VALUES
Values are variables that can be defined in the Workflow templates and used in the Workflow actions.
Such values are included in the workflow history Log file.

Typically, values are used to store the original value, the new value, the cut off limit.

REASSIGN STEP: 
Use this button to reassign a workflow to another user or user group.

If you have added a Reassign Step in the workflow template, the Reassign Step will include the con-
figured actions instead of the default one.

DELETE:
Use this button to remove a workflow instance from the console.

If the workflow is configured to "Auto-delete when complete", this will delete the workflow instance
from the console and the Workflow log will be updated.

If the workflow is NOT configured to "Auto-delete when complete", this will update the workflow
instance to clear the next step to complete the workflow. No specific actions will be taken by that
action. You can use DELETE again to remove the instance from the console.

NOTE ON COMPLETED WORKFLOWS
When a workflow is complete (the instance has been through a "Complete" Action), the step name
on the console is blank.

Many workflow templates are setup as "Auto-delete instance when complete". This option deletes
completed workflow from the console.

If the instance is deleted when the workflow is complete, the workflow log keeps the audit trail of pre-
vious workflow instances. Go to Extender Inquiries > Workflow Summary Log or Workflow Detail Log
to view workflow history that have been deleted from the console.

Refer to Workflow Summary Log on page 131 or Workflow Detail Log on the next page

workflow template configuration and console layout
Refer to Workflow Templates - Screen Guide on page 90 and Configurator Actions on page 136 for
details. It is recommended practice to include the actions below in all steps of the workflow templates to
make the console and workflow history log clearer and suited to your business practice.

DESCRIPTION
Use the SetDescription action in the workflow template to set the Workflow Status in the console and
in the workflow log depending on what step of the workflow you are in.

STATUS
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Use the SetStatus action in the workflow template to set the Workflow Status in the console and in
the workflow log depending on what step of the workflow you are in.

ROW COLOURS
You can configure the workflow using the AssignColour action to assign a colour in the console
depending on what step of the workflow you are in.

WORKFLOW DETAIL LOG
This screen lets you view the workflow detail log, including all steps each workflow instance has followed.

Every time a step is run, an entry is made in the workflow log table.

HOW TO USE
Use CTRL F to filter by any columns on the screen.

If you want to find all "AR Credit Limit" workflow steps, select the Template ID Column, CTRL F, and
select the Template you want to filter by. You can then add other filter criteria by selecting a new
column and selecting CTRL F again.

FILE MENU TO CHANGE SORT ORDER.
Use the File Menu to change the Sort order, based on the workflow Start Date/Time.

Sort Oldest Record First
Sort Newest Record First

WHAT IS INCLUDED IN THE DETAIL LOG
Clicking Values will show the values associated with this log entry.

If the Last Step is blank, it generally means the workflow is completed as there are no more steps to
follow.

The workflow status is updated when the SetStatus action is included in a workflow step as per the
workflow template configuration. It is recommended practice to ensure each step in the workflow
includes a "SetStatus" action to make the log easier to read at a glance.

The Description in the workflow log is set using the SetDescription action in the Workflow Template
configuration.

SECURITY GROUP
Need View Workflow logs security group

Workflow Log buttons
REFRESH

Use this button to refresh the details on the screen.
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For example, if new workflow have been started, progressed or completed since you opened the
screen.

DRILL DOWN
When configured in the workflow template, each workflow instance allows drilling down to a Sage
300 screen– for example, you could drill down to the customer, or to the order.

A workflow instance has a list of values associated with it – for example, a customer number or an
order number. Drill down works on this list of values. Refer to details in Drilldown in workflow on
page 146

Example:
If the workflow has a value called IDCUST then drill down to the AR Customer screen will be
enabled for the workflow.

VALUES
Values are variables that can be defined in the Workflow templates and used in the Workflow actions.
Such values are included in the workflow history Log file.

Typically, values are used to store the original value, the new value, the cut off limit.

WORKFLOW SUMMARY LOG
This screen lets you view the workflow summary log, including users who started the workflow and date
when the workflow was started.

Every time a workflow is started, an entry is made in the workflow summary log table. The latest step and
latest workflow status are updated when the workflow progresses through the various steps.

HOW TO USE
Use CTRL F to filter by any columns on the screen.

If you want to find all "AR Credit Limit" workflow steps, select the Template ID Column, CTRL F, and
select the Template you want to filter by. You can then add other filter criteria by selecting a new
column and selecting CTRL F again.

Tip: Double click on the Template name to open the workflow template screen if you have security
rights to Edit Workflow setup. For details, Workflow Templates - Screen Guide on page 90

Tip:
You can double click on columns in the Summary Log to open the Details Log screen.

Use the Values button on the Details Log to view values configured in the workflow for each step.

FILE MENU TO CHANGE SORT ORDER.
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Use the File Menu to change the Sort order, based on the workflow Start Date/Time.

Sort Oldest Record First
Sort Newest Record First

WHAT IS INCLUDED IN THE SUMMARY LOG

The Summary Log shows the Step that the workflow is on and the last status update.

Clicking Details will show the detailed steps associated with the selected workflow entry.

If the Last Step is blank, it generally means the workflow is completed as there are no more steps to
follow.

Note: The workflow status is updated when the SetStatus action is included in a workflow step as
per the workflow template configuration. It is recommended practice to ensure each step in the
workflow includes a "SetStatus" action to make the log easier to read at a glance.

The Description in the workflow log is set using the SetDescription action in the Workflow Template
configuration.

SECURITY GROUP
Need View Workflow logs security group

Workflow Summary Log buttons
REFRESH

Use this button to refresh the details on the screen.

For example, if new workflow have been started, progressed or completed since you opened the
screen.

DRILL DOWN
When configured in the workflow template, each workflow instance allows drilling down to a Sage
300 screen– for example, you could drill down to the customer, or to the order.

A workflow instance has a list of values associated with it – for example, a customer number or an
order number. Drill down works on this list of values. Refer to details in Drilldown in workflow on
page 146

Example:
If the workflow has a value called IDCUST then drill down to the AR Customer screen will be
enabled for the workflow.

DETAIL LOG
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Use the Detail Log button to view details of previous actions on the workflow record selected on the
console.

Tip:
You can double click on columns in the Summary Log to open the Details Log screen.

Use the Values button on the Details Log to view values configured in the workflow for each step.

PRINT WORKFLOW HISTORY LOG REPORT
Open Extender > Extender Reports > Workflow History Logs.

Select the default report or Browse to find a custom report.

Tip:
Extender includes one default report VIWFHistLog.rpt. You can duplicate the report, rename it and use
Crystal Reports to create your own report.

Make sure it includes the same parameters as the default report if you want to run it from the Extender
screen.

REPORT PARAMETERS
From and To Workflow ID: used to identify the range of Workflow templates to include on the
report.

From Step/To Step: Enter Steps to filter by in the report. Refer to the workflow template for the step
name.

Filter by Step refer to the "Step Name" as per the Workflow Detail Log Inquiry screen.

From Date/ To: field to identify the range of events to be included on the report

From User /To: to restrict the range of events to a single user. If left blank, all users will be included
on the report

From Record Key / To: Enter the Key fields you need the report to filter by. Refer to the Inquiries >
Workflow Summary Log

Show Details: 

Select Yes to include all steps that the workflow instances have been through.

Select No: The report will only include one row per workflow instance, including the latest step and
status.
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Note:
If the report "Show Details" is set to "Yes", the User refer to the user who performed the workflow
step and the date is the date/time when the workflow step was performed.

If the report "Show Details" is set to "No", the user refers to the user who started the workflow and
the date is the date the workflow was started.

USING EXTENDER TRAY ICONS
If configured in Information Manager and you are setup as a Workflow User, you can use icons on the
Sage 300 screens to start a workflow, progress an existing workflow or view workflow history.

Refer to Workflow Icons Explained on page 135 for a detailed description of the icons.
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Workflow Technical Info

Workflow Icons Explained 135
Configurator Actions 136
Using Parameters in Workflow 145
Drilldown in workflow 146
Workflow Best Practices Tips 150
Writing custom actions for Workflow 153
Remote Action Service : Progress Extender Workflow remotely 155
Remote Action Service - Getting Started 156

WORKFLOW ICONS EXPLAINED
Workflow icons only show if a workflow is configured, the user is configured as a Workflow User, and
the Information Manager tray is started.

To setup workflow icons in Sage 300 screens, refer to Extender Workflow- Notes/DML/Extender Tray

One or no workflow icon can be present per screen. Subject to Sage 300 security rights, you can use the
icons to view the workflow history.

Depending on the workflow configuration, you can also use the icons to start or progress the workflow.

Click to start manual workflow or view workflow history. There is no pending workflow.

Click to view active workflow. The pending workflow is not assigned to the logged on user.

Click to progress your active workflow. The workflow is assigned to the logged in user and waiting
for an action.

Click to progress group active workflow. The workflow is assigned to a workflow user group that
the logged in user is part of. The workflow is waiting for an action from one of the group member.

Note: If the workflow icons are not configured in Information Manager Options, users can run the
workflow Log reports to view workflow history. Workflow users can use the workflow console to view
and progress their active workflows.
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Note:
If the Information Manager Tray is not started, the icons will not show and the user will not be able to
use the workflow icons to start or progress the workflow.

However, workflows attached to view operation or view field changes will be started and users con-
figured as Understanding Workflow Users on page 83 are able to access the Workflow Console.

You can start the tray manually in Information Manager > Tray Icon.

CONFIGURATOR ACTIONS

Action Name Description Parameters

AssignUser
Assign to a Work-
flow User Group

Select a user group.

To configure a new user group, refer to
Workflow User Groups on page 85.

AssignUser
Assigns a user to
the workflow
instance

You can type a Sage 300 User ID, select a
value defined in the workflow or select a
value set in a parameter when attaching
the workflow to a view.

Type {USER} to assign workflow the cur-
rent user.

When you assign a workflow to a user
who is not configured as a Workflow User,
the AssignUser workflow action returns an
error. The next action is configured in the
False Action # field in the Workflow Tem-
plate.

Make sure the Workflow Template noti-
fies an Admin user and proceeds with the
rest of the workflow actions.

Tip: You can add a Workflow Action to
assign the workflow to ADMIN if the first
AssignUser action returns False

AddParameter

Stores input col-
lected in the work-
flow

Parameters are
added to the Values
of the workflow

Name: can be used in other actions (such
as set field or sendEmail)

Parameters

Label: description user will see when
prompted
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Type: 

Parameter types can be:

> text(size=xx)

> integer

> number.0 - eg 10.1

> number.00 - eg 10.12

> number.000 - eg 10.123

> user - a user or user group

> date

Default Value: Optional -

Parameter values (as entered by the user )
are saved as workflow values and avail-
able on the console.

Parameters can be added to email tem-
plates. Use {PARAMNAME} in the email
template.

AskForParameters

Step will stop at that
step and wait for
user input.

True Action should
be the action you
want to perform
when user has sub-
mitted the input.

No parameter.

Execution continues at the AskForPara-
meters True Action step #.

If the user selects "Cancel" on the UI, the
action returns False.

Tip: Configure the actions in the template
if you want different process flow if a user
enters input or clicks Cancel.

This action is not active when the work-
flow is progressed through a script, for
example the Remote Action poller.

AssignColour

Assigns a color to
a workflow
instance in the
Wokflow Console

Select a color using the Finder.

To configure colors, refer to Workflow Col-
ours on page 85

Complete
Action to ensure that
the action completes
the workflow.

No Parameter.

When the workflow is complete, no fur-
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If Auto delete
instance when com-
plete is set to Yes on
the workflow, the
instance will be
deleted when the
Complete step is suc-
cessful

ther processing happens.

The next step in the Console shows as
Blank

CreatePOfromReq
Create a PO from a
requisition

Requisition requires a vendor on the
Header. All lines must use the same
vendor. No parameters

Evaluate
Used to set con-
ditional workflow

Field, Operator, Value

If evaluating a Boolean field, use 1 for
True/Yes or 0 for False/No

Notes:
If the Field is set to {PROGRAM}, the
action will compare the RotoID of the
screen running the workflow to the value
defined in the Value parameter.

If you only want the workflow to do cer-
tain actions for certain users, you can use
Evaluate {USER} to use the logged on user
in the condition.

Gen-
erateAPPaymBatchListing

Runs and saves as
a PDF the
AP Payment Batch
listing report

For use in a workflow template to
approve AP Payment batches

See example in A/P Payment Batch
Approval on page 42

GetOptField

Used to read
Optional Field
Value to use in
workflow

Parameter 1 = Optional Field View ID -
Use View Info to select - Use PO0623 for
PO Header Optional Fields or G/L0400 for
GL Account Optional Field

Parameter 2 = Optional Field Name

Parameter 3 = Workflow Value

GoToStep Go to another work-
flow step. Select Step name

IfWorkflowExists
Returns True if
there is a pending

Can be used in the workflow template to
have different actions if the workflow is
Active.
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workflow.

Can also be used in View Events
and Scripts to make a field ReadOnly if
using Extender Customizer or Developer
Edition.

IfWorkflowUI

Returns True if the
workflow is pro-
gressed on the
Console or the
workflow screen
icons.

Used in the workflow template to have dif-
ferent branches if the step is used on the
console and in a script such as the
Remote Action Poller.

Users are generally not prompted for para-
meters or displayed messages when the
workflow is progressed in a script.

IsDelete

Returns True if the
workflow is part of
a DELETE view
operation.

This only applies to Master file and Trans-
action views.

When a batch is "Deleted", the status is
set to "Deleted", the Delete view oper-
ation is not run.

Tip: Use the Batch status field on the
Batch if you need to trigger a workflow
when a batch is deleted.

IsInsert

Returns True if the
workflow is part of
an INSERT View
operation

Can be used when a workflow is attached
to an UPSERT View operation or a View
Field.

This only applies to Master file and Trans-
action views.

When a batch is "Inserted", the batch is
created immediately without running an
"INSERT" View operation.

Tip: Use the Number of Entries field on
the Batch if you need to trigger a work-
flow when a batch is inserted (Number of
entries = 0)

IsUpdate

Returns True if the
workflow is part of
an UPDATE View
operation (vs an
INSERT)

Can be used when a workflow is attached
to an UPSERT View operation or a View
Field.

You may have different actions when a
new ON HOLD order is inserted vs when
an existing order is updated to "On hold"
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IsUserMemberGroup

Return True if the
user configured in
Parameter 1 is part
of the Workflow
User Group in para-
meter 2

To use it for the logged on user, you
can use {USER} in Parameter 1

Reassign

Reasssign a user to
another user/group

Displayed in the
workflow console.

If there is no reassign step then the user is
prompted for the user/group to reassign
to, then the workflow user is set to that
user. If you have a step called "reassign"
in your workflow, the custom step is run.

Example: If you want to send an email
when a workflow is reassigned, add your
own Reassign Step.

PostBkEntry PostBkEntry

The PostBkEntry posts the bank entry con-
figured in the Workflow Instance ID. Use
in a workflow template associated with
the Bank Entry View.

Approver needs rights to post Bank Entry
in Sage Security

PostBatch

PostAPAd-
justmentBatch

PostAPInvoiceBatch

PostAPPay-
mentBatch

PostARAd-
justmentBatch

PostARInvoiceBatch

PostARReceiptBatch

PostARRefundBatch

PostGLBatch

ProvPostGLBatch

The Post_Batch actions post the relevant
batch. Batch number entered as Para-
meter 1.

The approver needs rights to Post the
batch in Sage security.

SendEmail

Sends an email to
the user / user
group or email
address con-
figured in Para-

Parameter 1 = Email template - You can
use the finder to select the message tem-
plate.

Parameter 2 = Email address or Sage 300
User or Workflow user group.

User
pro-
file
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meter 2.

You can use {CURUSER} to send a noti-
fication to the user assigned to the work-
flow. Make sure the SendEmail Action is
after the AssignUser Action.

Note:

In Parameter 2, enter a list of

email addresses separated by a

;

You can add email addresses

(someone@company.com, a

Sage User ID or an Extender

workflow user

If selecting a Sage 300 user (eg

ADMIN), an email is sent to the

email address configured

in Sage 300 User profile.

If selecting a Workflow user

group (eg APPROVERS), all

users in the group are sent an

email, to the email address con-

figured in Sage

You can combine email

addresses (e.g. someone@-

company.com) and user groups

Example: someone@-
company.com;ADMIN;APPROVERS;
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Optional: CC, Subject (to overwrite email
template subject)

SendEmailAttachments
Sends an email
with an attach-
ment

Extender Message template - Can include
variables from the view the workflow is
attached to

Email address configured in Parameter
2: refer to SendEmail action above.

Set the path and filename of the attach-
ment in a Workflow value and enter the
workflow value name in P4.

Ensure the path is set to UNC format and
the users have access to it.

SendEmailToStarter
Sends an email to
the user who star-
ted the workflow

Email template, CC, Subject

SetDescription

Sets the workflow
description for use
in Console and
workflow logs.

You can use any string/word as well
as workflow and view variables.

SetDrilldown

SetDrilldown sets
a value to a Sage
300 view field to
enable Drilldown
from the console
to the underlying
Sage 300 screen.

Parameter 1 is the field name that is used
as the KEY field in the vidrilldown.ini file.

Parameter 2 is the value you want to set.

For example {IDCUST} for the customer
number from an ARCUS workflow.

For details, refer to Drilldown in workflow
on page 146.

SetField

Sets a configured
field to a value.

Field can be any field
on the view that the
Workflow will be
attached to

Use Extender Extender View
Info to identify the Field name
e.g. AMTCRLIMIT for an
A/R Customer workflow
Add the field name between
curly brackets {}.
Use values defined in the work-
flow or a set value (e.g. 1 to set
OnHold to true/selected)

You can use {VIEWID}, {VIEWKEY},

Page 142 of 162 Workflow Technical Info

../../../../../../Content/Extender/VI-Setup/VI-ViewInfo-1005.htm
../../../../../../Content/Extender/VI-Setup/VI-ViewInfo-1005.htm


Orchid Modules

{KEYDESC}, {TOVALUE} - these correspond
to the View ID, Record Key, Description,
and Requested Value columns in the
Workflow Console screen.

Example: To prevent a change to the
credit limit, you use SetField to restore the
value to the previous value using SetField
and {ORIGINAL_AMTCRDLMT}

Note: You can update 2 fields with
SetField . This is useful when updating
SalesPerson and SalesPercentage on
OE Order.

SetOptField
Set an optional
field value

Parameter 1 = Optional Field View ID -
Use View Info to select - Use PO0623 for
PO Header Optional Fields or G/L0400 for
GL Account Optional Field

Parameter 2 = Optional Field Name

Parameter 3 = Optional Field Value

SetStatus

SetStatus will set
the status of a
workflow instance.
The Status is
shown on the
workflow Console

P1 is the status you want to set to the
workfow instance. Displayed on the
console, on the worklfow logs and in
the workflow reports.

SetValue

SetValue will add a
row to the work-
flow instance val-
ues grid.

Parameter 1 is the field name that you
want to give to the Value.

Parameter 2 is the value you want to pass.
It can be hard-coded, set to a value
defined in the workflow or set to the View
Field original or new value.

Use the field name between curly bracket
to store the new amount (e.g.
{AMTCRDLMT}

P1 can be set to {VIEWID} and value
would be the Sage 300 View ID when a
workflow is started from a screen and not
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attached to a view.

ShowUserError
Displays a Error to
the logged on user
on the Sage screen.

As above.

ShowUserMessage

Displays a Message
to the logged on
user on the Sage
screen.

Parameter 1: Text to display.

For information The message can
include Variables, such as Workflow fields
or Values from the workflow.

Use an Evaluate action before using the
ShowUser actions to ensure that the mes-
sage is only showing when the view is
used on a Sage 300 screen.

field: "{PROGRAM}"

operator: "="

value: "AR1300" (RotoID of the screen
that should display a message).

ShowUserWarning

Displays a Warning
to the logged on
user on the Sage
screen.

As above.

Parameters to be used in workflow actions
The following values are available to use in action parameters and email templates used in the Work-
flow.SendEmail action:

{$1}, {$2}, {$3}, {$4} - step parameters

{PROGRAM} ID of calling program (eg OE1100 = Order Entry)

{ROTOID} ID of the calling view (eg AR0024 = AR Customers)

{USER} current user (eg ADMIN)

{field} gets a value either from the workflow instance values, or from the target view.

{VIEW.field} gets a value from the target view

{VALUE.name} gets a workflow instance value

{VIEWID} the view ID for this workflow instance

{VIEWKEY} the record key for this workflow instance

{KEYDESC} the description for this workflow instance

{TOVALUE} the requested value for this workflow instance

{STATUS} the current status for this workflow instance
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{COLOR} the colour for this workflow instance

{CURUSER} the user or group currently assigned for this workflow instance

{WTNAME} the workflow template name for this workflow instance

{STUSER} the user who started this workflow instance

{STEPNAME} the current step for this workflow instance

{PSTEPNAME} the previous step for this workflow instance

Formatting Numbers:

Append ':{required decimals}' to the field

E.G. {ORDTOTAL:2}

USING PARAMETERS IN WORKFLOW
Parameters can be used when attaching a workflow to a Extender view and when configuring the Pro-
gress To Steps.

To use the parameters in the workflow, use {$1}, {$2}, {$3} and {$4} in the entry step of the workflow.

Tip:
Remember to include a description of how the parameters are used in the workflow template.

Parameter 1 is to Parameter 4 is fields on the Steps setup section of the Workflow Template allow you
to describe how the parameters are used in the workflow.

PARAMETERS AND VIEW EVENTS AND SCRIPTS
You can configure up to 4 parameters when attaching a workflow to a Sage 300 View in View events
and scripts.

To use the parameter value and store it as a workflow value, include a SetValue action in the Entry
Step step

PARAMETERS AND PROGRESS TO STEPS
Each of the Progress To steps can also include up to 4 parameter fields that the next steps can use.

To use the parameter value and store it as a workflow value, include a SetValue action in the Pro-
gress-to Step step

SetValue and parameter example.
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PARAMETERS AND MANUAL WORKFLOW.
When configuring screen icons in Information Manager > Notes/DML/Extender Tray, you can enter
up to 4 parameters that can be saved in the workflow in the Entry Step.

Refer to Extender Workflow- Notes/DML/Extender Tray .

DRILLDOWN IN WORKFLOW
Drilldown is the ability to open a Sage 300 screen from the workflow console.

Requirement! Users need to be configured as a Workflow User and have security rights in Sage 300 to
the relevant module and functionality.
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Note:
Drilldown opens the Sage 300 screen and includes customisations done with Extender OCX scripts
(new buttons, etc). If there are Information Manager Notes or Document Management Link details con-
figured for the screen, they will open too.

Using the SetDrilldown action configured in the vidrilldown.ini or
viuserdrilldown.ini files
To enable drilldown for a workflow, you need to configure the key fields you want to drill down to in the
workflow template.

You use SetDrilldown action, Field= Sage 300 key field name (e.g. IDCUST) and Value = {IDCUST} - name
of the key field in the Sage 300 view.

TO FIND OUT THE FIELD NAME TO USE
You can also look at the vidrilldown.ini file in the VIXXA folder of your Extender installation.

CONFIGURING CUSTOM DRILLDOWN.
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Drill downs are defined in the vidrilldown.ini file. Do not modify the vidrilldown.ini file as it could be
overwritten with a product update.

Users can add their own viuserdrilldown.ini file in the customisation folders to add additional drill-
downs.

Drilldowns come from the following files:

1. The customization directory for the current user and organization

2. The customization directory for the current user and default organization

3. The customization directory for the default user and current organization

4. The default customization directory

5. The vixxa folder

Example: Custom Table in Extender

If you want to configure Drilldown to an Extender custom table, you need a custom script to dis-
play the table myscript.py and configure a custom drilldown in the viuserdrilldown.ini file.

vidrilldown.ini entry for custom tables

RotoId=VI1007 
Parameters=SCRIPT=myscript.py\nDOCNUM=%value%

Tip: If you see multiple records for the same drill down, it is likely that the same configuration
exists in the vidrilldown.ini and a viuserdrilldown.ini files. Ensure that the viuserdrilldown.ini file
only includes custom options that don't exist in the default file.

Examples: [A/R Customer Number]

Use SetDrilldown , Drilldown field name = {CUSTOMER} (as per the drilldown.ini file, Value =
{IDCUST} as per the ARCUS View field name.

Fields=IDCUST

RotoID=AR1300

Parameters=IDCUST={IDCUST}

DrillDownText=Open A/R Customer {IDCUST}
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O/E Order Number workflow

You can add SetDrilldown IDCUST to the current order customer and SetDrilldown ORDNUMBER for
the current Order. When looking at that order on the Console, you can drill down to the Customer or
to the Order.

A/P Payment Batch

SetDrilldown: Field = PYBATCH or APPAYBATCH, Value = {CNTBTCH} for batch number

A/P Invoice Batch

SetDrilldown: Field = APINVBATCH, Value = {CNTBTCH} for batch number
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Using Workflow value to configure drilldown
You can add a workflow value called "DRILLDOWN.xxx" where xxx can be up to 10 characters. This is use-
ful to drilldown to screens that don't have key values.

The value should be either:

desc|rotoid, or

desc|rotoid|parameters

Examples:
To drilldown to the EFT Options screen, with no key value, add a workflow value DRILLDOWN.EFT =
EFT Options|EL2000

To drilldown to the GL Batch , you can add a workflow value DRILLDOWN.GLBATCH . Value GL
Batch|GL2100|BATCHID={BATCHID}\nENTRYNBR=1

WORKFLOW BEST PRACTICES TIPS

General
1. Plan the workflow and draw a flow chart including key steps and decision points.
2. When a workflow is attached to a view field or view operation, every time the view field changes, a

workflow instance is created (even if no approval is required).

Note: If you only want the workflow to start in some circumstances, you need a custom script
and a license for Extender Customizer or Developer.
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3. Set "Auto-delete instance when complete" to Yes for most workflow. This enables you to use the
Console to manage outstanding tasks assigned to you / your group in pending workflows. The
Workflow inquiries can be used to view all previous workflows.

Actions in workflow template
COMPLETING WORKFLOW

Ensure the key branches in the workflow end with a "Complete" step. If the workflow is not com-
pleted, and there are no Progress To Actions, you need to use the "DELETE" button on the console to
clear the console.

TRUE/FALSE ACTIONS
When using SetField action in particular, ensure you have different actions for True / False

False action on critical actions of the worklow should go to a step called "ErrorMessage" that sends
an email, sets the colour to Red, assigns the record to a Power user.

SetField can return "False" if the field name is wrong or if the assigned user doesn't have sufficient
rights in Sage 300.

VALIDATING WORKFLOW ACTIONS

Check spelling of the step when using GoToStep, ensure the step exists in the work-
flow. If you rename a step in the workflow, make sure you check all the actions. If
not, users will receive an error message "Step ABC does not exist" and the workflow
will not progress to the next step.

Approval workflow to prevent fields being updated.
1. To prevent a field from being changed, the entry step needs to have an action SetField

= {ORIGINAL_FIELDNAME} (e.g. {ORIGINAL_AMTCRLIMT}). This action is required
whether there is a workflow active or not.

2. When the change is approved, the Approval step needs an action to set the field value
to the requested value SetField = {TOFIELD}

3. Workflow "Can start multiple instances" should be set to Yes and if you want to control
what happens when there is an active workflow, use the IfWorkflowExists action.

4. In most cases, when an active workflow already exists (IfWorkflowExists action = True),
the workflow displays a message to users if run from a Sage 300 screen and completes
the new workflow, leaving the original workflow instance active.
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Example:
In the A/R Credit Limit approval: 

Check step includes an action to restore the old credit limit using SetField. This action is run whether
there is a workflow active or not.

SetField {AMTCRLIMT} = {ORIGINAL_AMTCRLIMT}

Approve step includes an action to set the credit limit to the requested credit limit

SetField {AMTCRLIMT} = {TOVALUE}

Actions in steps and workflow console
Refer to Workflow Templates - Screen Guide on page 90 and Configurator Actions on page 136 for
details. It is recommended practice to include the actions below in all steps of the workflow templates to
make the console and workflow history log clearer and suited to your business practice.

DESCRIPTION
Use the SetDescription action in the workflow template to set the Workflow Status in the console and
in the workflow log depending on what step of the workflow you are in.

STATUS
Use the SetStatus action in the workflow template to set the Workflow Status in the console and in
the workflow log depending on what step of the workflow you are in.

ROW COLOURS
You can configure the workflow using the AssignColour action to assign a colour in the console
depending on what step of the workflow you are in.

Tip: You can use SetValue {TOVALUE}, insert a field from the record, such as {ORDTOTAL} when attach-
ing a workflow to a View operation to have visibility in the console and the workflow logs.

Configurator actions that require another one.
To prompt a user for parameter, you need to use " AddParameter" and " AskForParameters".

To display a message on a screen where the workflow is triggered, use Evaluate to check that the pro-
gram is a Sage 300 Screen / Roto ID and then ShowUserMessage or ShowUserWarning or ShowUserError
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WRITING CUSTOM ACTIONS FOR WORKFLOW
When using Extender Customizer or Developer Edition, you can write or import custom workflow actions.
Workflow actions are Python Extender Scripts that follow certain rules. For details on Extender scripts,
refer to Scripts

Naming Extender scripts used as Workflow Actions
User defined Custom Workflow Actions must contain the string “Workflow” in their name to allow
Extender to identify them as Workflow Actions:

[MODULE NAME].Workflow.ActionName

ActionName should be a short descriptive name with no spaces.

Tip: For details on Extender modules, refer to Modules

Scripts return value
The scripts that define the custom actions are expected to return 0 for success, 1 for failure.

Note:
The result from a custom action determines whether the workflow will follow a True or False decision
branch.

Traditionally, 1 represents True, 0 represents False.

However, Workflow custom actions return 0 = True, 1 = False.

This falls in line with the 0 = success, 1 = failure convention prevalent in Sage 300 SDK development.

Therefore, for a custom action to direct a workflow down a True branch, it must return 0 (not 1).

Workflow actions and parameters
Use Parameter at the top of the script to define parameters and field names in the grid

Actions have up to 4 parameter fields
In the workflow template, you can assign a value to the parameter, up to 250 characters for each para-
meter.

Parameters are called P1, P2, P3 and P4. Each is given a label in the script.
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Parameter Labels in workflow action

## P1 Template
## P2 To
## P3 CC
## P4 Subject # leave blank to use the template subject
## P1.FinderView=VI0008
## P1.FinderField=MSGID
## P1.FinderFields=MSGID,TEXTDESC,COMMENTS,BODY

Workflow actions can have finders for the parameters.
You need to configure FinderView for the Sage 300 view storing the details, FinderField for the key field
and FinderFields for the fields you want to view in the finder grid.

Use FinderOrder to set the View Index for the FinderField

Use FinderFilter to filter the records.

Look at the Workflow.AssignColour or the Workflow.SendEmail workflow actions for example scripts.

Finder for workflow action parameter

## P1 Customer # for a finder to select an active customer setup in AR
## P1.FinderView=AR0024
## P1.FinderField=IDCUST
## P1.FinderFields=IDCUST,NAME
## P1.FinderOrder=0  #Key number
## P1.FinderFilter=SWACTV=1 #valid filter string including FIELDNAME=VALUE.
## P1.FinderFilter=IDGRP="RTL"  #example with a string

Examples: 
If you want to start a workflow when a Customer's address details are updated, you can configure a work-
flow on each address field you want to track. However, this would create a workflow record for each field.
So you would need to approve change to each field separately. You could also attach a workflow to an
{UPDATE} view operation and the workflow would include a series of Evaluate actions to identify which
fields have changed. While this would work for 2 or 3 fields, it might become cumbersome for all the
fields that make up an address.
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You could write a custom action "HasAddressChanged" that would return 0 if any address field has
changed, 1 if no address field has changed.

REMOTE ACTION SERVICE : PROGRESS EXTENDER
WORKFLOW REMOTELY
When a Workflow Action is assigned to an individual (or group member), they can be notified by email.
That email is configured to contain a unique hyperlink to a Remote Action service web page/fleeting
form.

The Remote Action page is entirely independent from Sage 300, and merely requires internet access. The
form is unique to a given user and Workflow Action.

The form is configurable in the Workflow Template. E.g. it could include Approve and Reject buttons, cap-
ture a comment, and capture new values for a Sage 300 field related to the action.

Completed forms are pulled into Sage 300 when required. Orchid Process Scheduler can be used to poll
the Remote Action site automatically on a regular basis for newly completed action data, and feed the
results back into Sage 300 to progress the Workflow. Completed forms are then deleted from the web-
site.

To get started, refer to Remote Action Service - Getting Started on the next page

Refer to Online Help for details. Remote Action Service Online Documentation

Remote Action user guide can be found online: User Guides
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REMOTE ACTION SERVICE - GETTING STARTED
Remote Action service is used in conjunction with Extender workflow to enable approvals of Sage 300
records outside of the Sage 300 environment. Approvers receive a one time email link that they can use
to complete the Approval (or rejection) form.

For details on how it works - refer to Remote Action Service : Progress Extender Workflow remotely on
the previous page

In most cases, you configure the Extender Workflow as per your required flowchart first without Remote
Action Service. Once you have tested the workflow template, you can add a Remote Action Service
action to send the email to the approvers with the link to approve outside of Sage 300.

Example: Tutorial: Remote Action tutorial - A/R Credit Limit approvals
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Requirement!
The following modules are required to use the Remote Action Service: 

Extender (Configurator or Developer)
Workflow Users
Remote Action Subscription
Process Scheduler Level 1 and above to automate completed form retrieval (optional
but highly recommended)

Prerequisites - install Extender and Remote action service

Extender setup

Ensure the latest product update for Extender installed and activated.
In Extender Options, set the Python version to version 3.8.8 - Refer to Python Version
on page 74
In Extender Options > Email Tab, configure the SMTP Details as Remote Action service
needs to email. Refer toExtender Email Tab on page 75
Configure Workflow Users. Extender License and Workflow Users on page 82

Install Remote Action Service

Subscribe to the Remote Action Service through your Sage 300 Business partner and
have the token available.
Import the RemoteAction.vi module

REMOTE ACTION MODULE DETAILS
The Remote Action module includes the Extender custom tables and scripts required to configure
and manage the service.

Remote Action Scripts
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Workflow Actions

It also includes three workflow actions to build the form hyperlink and email the on-time link to the
workflow users.

SendRemoteActionCommentAmountFormEmail includes a comment and an amount field for the
approver to complete. Amount defaults to the requested value in the workflow.

Example: Used to Approve A/R Credit limit

SendRemoteActionCommentFormEmail: includes a comment field only.

SendRemoteActionFormEmail: No user input is captured. Form only includes the buttons configured
in the workflow template.

Custom Table and Configuration record

Remote Action includes a default handler in the Remote Action Handlers custom table for use with
the workflow. This is created when you install Remote Action module. In some rare cases, if the con-
figuration record is missing, you may need to add it manually.

Form Type: workflow_approval

Handler Class: remote_actions.handlers.workflow_approval.WorkflowApprovalFormHandler

Install Process Scheduler

Although this is optional, it is highly recommended to automate the retrieval of the completed remote
action forms. Refer to Running the Poller with Process Scheduler on page 160
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Configure Remote Action module
Step 1: Go to Remote Action menu, select Configure and enter the token provided.

Note: If you don't have a token, contact your Sage 300 Business Partner to enable the service.

Step 2: Run Remote Action Option - Optionally, enter a website address for the logo you want to see
on the form and an email address to be displayed on the form. For details, refer to Remote Action
Admin.

Step 3: Add Extender Message templates to configure the notification email and the remote form con-
tent. For details, Remote-Message-Templates

Step 4: Include one of the Remote Action in a workflow template - For details, Add Remote Action
Workflow Template

Configure Remote Action poller
To process the remote requests into Sage 300, you can run the Extender RemoteAction.poller script. The
script is in the Extender > Remote Action menu

Note: The script can only be run manually by the ADMIN user.
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POLLER DESCRIPTION

Poller is an Extender script designed to process all completed requests and bring the action results
into Sage 300 to progress the workflow.

The RemoteAction.poller connects to the Remote Action Service to retrieve and process completed
forms. For each form, it progresses the workfow according to the details submitted by the user on
the Remote Action form.

For example, if the user approves the workflow request, the workflow status is updated as per the
Approve step configured in the workflow template.

If the poller encounters any error, for example another user has already approved the workflow,
using their Remote Action link or using the Extender console, the poller will log an error.

Running the Poller with Process Scheduler

In most cases, you configure Process Scheduler to run the script and use Windows Task Scheduler to
update the data automatically as often as required.

Setting Up Process Scheduler - Configure Process Scheduler to run the imports automatically

Setting Up the Windows Scheduled Task - Task Scheduler

Tips:
The user configured in Process Scheduler Companies needs to have "Modify all workflow" rights in
Sage Security Groups as it needs to progress the workflow records. It also needs to have all the Sage
security rights to perform the actions in the Approve/Reject steps (e.g. Post batches, update Customer
or Vendor).

It is important that an admin user reviews the Process Scheduler Logs regularly.

Page 160 of 162 Workflow Technical Info

../../../../../../Content/RemoteAction/Configure-Process-Scheduler-TOC.htm
../../../../../../Content/RemoteAction/TaskScheduler.htm





	Extender Configurator Tutorials
	A/R Credit Limit Approval
	Overview
	EXTENDER SETUP KEY STEPS
	Workflow template - Step by step guide
	Attach workflow to AR0024 {AMTCRLMT} Field
	Configure Information Manager
	testing Sage 300 workflow setup

	Customer On-Hold Alert and Approval
	Overview
	Extender Setup key steps
	Workflow template - Step by step guide
	Attach workflow to AR Customer Inquiry screen
	Using Extender workflow to set customer on hold
	Use Icon on AR Inquiry screen to put on hold
	Viewing workflow history and logs


	O/E Orders Approvals
	Overview
	Extender Setup key steps
	Workflow template - Step by step guide - OE New Retail orders on hold
	Workflow template - Step by step guide - O/E orders on hold approval
	Attach workflow to OE0520 View
	Configure Information Manager
	Using Extender

	P/O Requisitions and Purchase Order Approval
	Overview
	EXTENDER SETUP KEY STEPS
	Configure SMTP Email settings in Extender Options
	Configure Workflow Users
	Create Workflow User Group
	Add Workflow colours
	Import the PO Approval.vi file
	Configure the PO approval module - Print settings
	Configure the PO approval module - User delegated amount and manager
	Configure approving user
	Optionally, configure module to use Remote Action in workflow template
	Auto approve PO from requisitions –

	Workflow template - Step by step guide
	testing Extender workflow setup
	Start the workflow
	Approve or Reject the Purchase Order or Purchase Requisition

	Software Required

	A/P Payment Batch Approval
	Overview
	EXTENDER SETUP KEY STEPS
	Configure SMTP Email settings in Extender Options
	Configure Workflow Users
	Create Workflow User Group
	Add Workflow colours
	Import the AP Payment Batch Approval.vi file
	Configure the AP Payment approval module

	Workflow template - Step by step guide
	testing Extender workflow setup
	Start the workflow
	Approve or Reject the A/P Payment Batch

	Optionally, Configure Information Manager
	Software Required
	Using with Remote Action Service

	Vendor Alert Manual workflow
	Overview
	Extender Setup key steps
	Workflow template - Step by step guide
	Attach workflow to AP Vendor screen
	Using Extender workflow to start the AP Vendor manual workflow
	Use Icon on A/P Vendor screen to send an alert
	Viewing workflow history and logs


	I/C Options Notification
	Overview
	EXTENDER SETUP KEY STEPS
	Workflow template - Step by step guide
	Attach workflow to IC0380 {SEXPDAYS} Field
	Configure Information Manager
	Testing Sage 300 workflow setup


	Setting Up Extender Workflow
	Before you start
	setup workflow in extender
	Step 1. Use the icons in the Extender Setup folder to configure workflow:
	Step 2. Setup Extender Adding Security on page 1 in Sage 300 Administrative Services.
	Step 3. Configure Workflow Users.
	Step 4. If you want the workflow to send emails,
	Step 5. Create Workflow User Groups
	Step 6. Configure Workflow colors
	Step 7.                   Add Workflow Templates

	Apply Workflow to the required Sage 300 Views.
	A workflow can be started automatically
	A workflow can be started manually

	Optionally, add icons to Sage 300 screens
	Installing Extender
	Installation Steps
	Before you Start
	Installing the files

	Activate Extender
	License Details
	Enter License Details

	Upgrading from a prior version
	Minimum Requirements

	Extender License Screen
	License screen
	Workflow Users
	30-day Trial Licence
	Extender license screen details
	Subscription Licenses Expiry Date

	Extender and Orchid modules web screens
	Troubleshooting Activation Code
	Activation code and available functionality

	Adding Security
	Extender security and workflow users
	Custom Table Security

	 Options
	Options Tab
	Log User Sign in : Yes or No.
	Python Version

	Email Tab: enter Email server details
	Updates Tab


	Extender Email Tab
	Email Field details
	Basic Authentication SMTP:
	Microsoft Graph:

	Examples
	Test Email Configuration
	Troubleshooting Sending emails
	SMTP Email Examples
	Email with Office 365
	Using Office 365 and MFA
	Note: The details below are left in the documentation if your Office 365 setup supports basic SMTP Authentication and App Passwords. Email Server -> smtp.office365.com:587Email User -> username@samplecompany.comEmail Password -> Enter PasswordIf using Multi-factor Authentication and App Password, enter the App passwordl. For details, see Using Orchid Modules with Office365 and Multi-Factor Authentication Encryption: TLSTLS VersionYou don't select a specific TLS version. Orchid uses the .Net SmtpClient class to send emails. The SMTP Client uses the protocol configured on the operating system, based on the .NET version installed. The email function supports Ssl3, Tls1.0, Tls1.1, Tls1.2 and Tls1.3. Microsoft has recently stopped support for TLS1.0 and TLS1.1. Support for TLS 1.2 was added to Orchid modules in April 2020 and applies to Sage 300 versions 2018 and above. If you have any issues emailing, please ensure you download and install the latest product update for your Sage 300 version.

	Using Gmail
	Using SendGrid
	Using Hotmail

	Email Troubleshooting
	Failure sending mail
	Port
	Legacy Authentication
	TLS Version

	You get the message “E-mail sent”, but no email is received,
	Process Scheduler emailing tips


	Updates Tab
	Extender License and Workflow Users
	Maintain Workflow Users
	Upgrade Steps for Workflow Users

	Understanding Workflow Users
	Setup Workflow Users
	When do you need workflow users
	Workflow template and Workflow Users
	How do Workflow Users work?
	WORKFLOW USERS are NAMED user licenses:


	Workflow Colours
	Workflow User Groups
	Message Templates
	Message Templates Field List
	Message Variables
	Attachments
	To configure:
	How it works:

	Using HTML messages

	Workflow Templates
	Workflow Types
	A workflow can be started automatically
	A workflow can be started manually
	Completing a workflow

	Using the workflow
	Setup Workflow templates - Overview

	Workflow Templates - Screen Guide
	Workflow template configuration
	Workflow Steps
	Progress-to Steps
	Workflow Actions
	Workflow Values

	Link Workflow template to Extender view or Screen
	To start a workflow automatically:
	To start a workflow manually:
	View Events, Scripts & WF
	Select a Sage 300 View to be configured with Extender.
	Fields and Controls
	Events Tab
	Scripts Tab
	Workflow Tab

	Extender Workflow- Notes/DML/Extender Tray
	Configure Tray
	Fields and Controls
	Examples

	Configure Orchid User
	How do Orchid Users work?
	DML USERS ARE CONCURRENT (FIRST COME, FIRST SERVED) LICENCES:
	WORKFLOW USERS are NAMED user licenses:

	Setup DML User
	Setup Workflow User
	Setup Workflow Anywhere User


	Remote Action Service : Progress Extender Workflow remotely
	Remote Action Service - Getting Started
	Prerequisites - install Extender and Remote action service
	Extender setup
	Install Remote Action Service
	Install Process Scheduler

	Configure Remote Action module
	Configure Remote Action poller
	Running the Poller with Process Scheduler



	Using Extender Workflow
	To start a workflow manually:
	Progress Workflow on the Workflow Console
	Using Icons on Sage 300 screens
	Progressing Workflow Outside of Sage 300
	Using Remote Action Service
	Using Workflow Anywhere

	Workflow History
	Using Workflow Console
	Console and Security Groups
	how to use console grid
	how to use console buttons
	workflow template configuration and console layout

	Workflow Detail Log
	Workflow Log buttons

	Workflow Summary Log
	Workflow Summary Log buttons

	Print Workflow History Log Report
	Using Extender Tray Icons

	Workflow Technical Info
	Workflow Icons Explained
	Configurator Actions
	Parameters to be used in workflow actions

	Using Parameters in Workflow
	Drilldown in workflow
	 Using the SetDrilldown action configured in the vidrilldown.ini or viuserdrilldown.ini files
	Using Workflow value to configure drilldown

	Workflow Best Practices Tips
	General
	Actions in workflow template
	Approval workflow to prevent fields being updated.
	Actions in steps and workflow console
	Configurator actions that require another one.

	Writing custom actions for Workflow
	Naming Extender scripts used as Workflow Actions
	Scripts return value
	Workflow actions and parameters
	Actions have up to 4 parameter fields
	Workflow actions can have finders for the parameters.
	Examples:

	Remote Action Service : Progress Extender Workflow remotely
	Remote Action Service - Getting Started
	Prerequisites - install Extender and Remote action service
	Extender setup
	Install Remote Action Service
	Install Process Scheduler

	Configure Remote Action module
	Configure Remote Action poller
	Running the Poller with Process Scheduler



	Bookmarks
	AttachWFARCUS
	ConfigureEB
	Python
	Running


